[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




July 5, 2005


[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





         Adobe Acrobat Reader 5.0

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

       To find the next occurrence of the word: 

        Do one of the following:

        Choose Edit > Find Again 

        Reopen the find dialog box, and click Find Again.  (The word must already be in the         Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.

3. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]
SUP. MOLINA, CHAIR: GOOD AFTERNOON. WE'RE GOING TO BEGIN THIS AFTERNOON'S MEETING OF THE BOARD OF SUPERVISORS. AND THIS MORNING-- THIS MORNING, OUR INVOCATION WILL BE LED BY THE PASTOR JACK MIRANDA OF THE LIVING FAITH ASSEMBLIES OF GOD IN LA MIRADA AND OUR PLEDGE THIS MORNING IS GOING TO BE LED BY THOMAS WALSH, WHO IS THE FOURTH AREA CHILDREN AND YOUTH COMMISSIONER WITH THE AMERICAN LEGION. WOULD YOU ALL PLEASE STAND. PASTOR? 

PASTOR JACK MIRANDA: MEN AND WOMEN OF FAITH, WILL YOU JOIN ME IN A PRAYER? DEAR LORD, WE INVOKE YOUR PRESENCE INTO THESE PROCEEDINGS. I THANK YOU FOR YOUR PROVIDENCE, I THANK YOU FOR YOUR GRACE AND MERCY UPON THE LIVES OF THESE SIGNIFICANT LEADERS IN OUR COMMUNITY. WE THANK YOU FOR THE COUNTY OF LOS ANGELES, THE GREATNESS OF IT AND WE KNOW IT'S BY YOUR GRACE AND MERCY. NOW, LORD, WOULD YOU BE PRESENT IN EACH LIFE HERE, WOULD YOU EXTEND YOUR GRACE AND YOUR KINDNESS AND YOUR WISDOM ON THE DECISIONS THAT ARE MADE, THE IMPORTANT, SIGNIFICANT DECISIONS THAT AFFECT YOUR PEOPLE, YOUR CHILDREN. IN YOUR WONDERFUL NAME WE ASK. AMEN AND AMEN. 

THOMAS WALSH: PLEASE FACE THE AMERICAN FLAG, RIGHT HAND OVER THE HEART. [ PLEDGE OF ALLEGIANCE ] 

SUP. MOLINA, CHAIR: MR. KNABE? 

SUP. KNABE: MADAM CHAIR, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, IT'S MY PRIVILEGE TO WELCOME AND SAY THANK YOU TO MR. JACK MIRANDA, PASTOR OF LIVING FAITH ASSEMBLIES OF GOD IN LA MIRADA. WE WANTED TO THANK HIM FOR TAKING TIME OUT OF HIS BUSY SCHEDULE TO JOIN US. HE'S BEEN THE PASTOR OUT THERE FOR FIVE YEARS AND, FOR THE PAST 19 YEARS, PASTOR MIRANDA HAS ALSO SERVED AS A YOUTH COUNSELOR WITH THE CALIFORNIA YOUTH AUTHORITY. HE IS A BOARD MEMBER OF THE LA MIRADA CLERGY COUNCIL, THE CHAMBER OF COMMERCE AND THE KIWANIS CLUB OUT THERE IN LA MIRADA. PASTOR JACK, AS HE IS KNOWN, HAS BEEN MARRIED FOR NEARLY 27 YEARS. HE'S JOINED BY HIS WIFE OUT HERE TODAY AND THEY'RE PROUD PARENTS OF SEVEN CHILDREN AND I ALSO UNDERSTAND, IN A VERY SHORT PERIOD OF TIME, WILL BE HAVING THEIR FIRST GRANDCHILD, A LITTLE GRANDSON, SO GET ONE OF THOSE ANGELS OF GOD AND WE CAN SHARE PICTURES. OKAY? ANYWAY, THANK YOU VERY MUCH, PASTOR JACK. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: THANK YOU, PASTOR. SUPERVISOR BURKE? OR, NO, SUPERVISOR YAROSLAVSKY, I'M SORRY. 

SUP. YAROSLAVSKY: MADAM CHAIR, WE WERE LED IN THE PLEDGE THIS MORNING BY THOMAS WALSH, REPRESENTING THE AMERICAN LEGION, FOURTH AREA CHILDREN AND YOUTH COMMISSIONER. HE'S THE PAST DISTRICT 17 COMMANDER AND VICE COMMANDER AND PAST FOURTH AREA VICE COMMANDER OF THE AMERICAN LEGION. TOM SERVED IN THE UNITED STATES NAVY FROM 1966 THROUGH '69, WAS A HOSPITAL CORPSMAN, THIRD CLASS, IN THE VIETNAM WAR, SERVED DURING THE TET OFFENSIVE, RECEIVED THE MERITORIOUS UNIT COMMENDATION, THE NAVY GOOD CONDUCT MEDAL, THE NATIONAL DEFENSE SERVICE MEDAL, AND THE VIETNAM SERVICE MEDAL WITH TWO STARS AND THE VIETNAM CAMPAIGN MEDAL. HE'S A QUALITY IMPROVEMENT MANAGER AT L.A. COUNTY U.S.C. MEDICAL CENTER, SO HE'S ONE OF OUR OWN. HE'S LIVED IN OUR DISTRICT OR CLOSE TO OUR DISTRICT FOR 29 YEARS, ATTENDED CRESPI CARMELITE HIGH SCHOOL IN ENCINO, AND RECEIVED HIS-- WENT TO PASADENA CITY COLLEGE IN THE UNIVERSITY OF REDLANDS IN REDLANDS, CALIFORNIA. SO, TOM, THANK YOU VERY MUCH FOR LEADING US IN THE PLEDGE THIS MORNING AND FOR YOUR SERVICE TO OUR COUNTRY. [ APPLAUSE ] 

SUP. YAROSLAVSKY: WHAT'S YOUR SON'S NAME? KEN? WE'RE VERY PLEASED AND HONORED TO HAVE LINDA AND KEN, TOM'S WIFE AND SON, WITH US TODAY. PLEASURE TO HAVE YOU HERE. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: THANK YOU. CONGRATULATIONS AND THANK YOU. I'M GOING TO ASK OUR EXECUTIVE OFFICER TO PLEASE CALL THE AGENDA. 

CLERK VARONA-LUKENS: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD. WE'LL BEGIN ON PAGE 5. AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEMS 1-H THROUGH 3-H. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 11. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 12 AND 13. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ARTS COMMISSION, ITEM 14. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AUDIT COMMITTEE, ITEM 15. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: CHILD SUPPORT SERVICES, ITEM 16. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: COMMUNITY DEVELOPMENT COMMISSION, ITEMS 17 AND 18. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: HEALTH SERVICES, ITEM 19. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC LIBRARY, ITEM 20. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC WORKS, ITEMS 21 THROUGH 43. ON ITEM NUMBER 28, THE ACTING DIRECTOR REQUESTS THAT THE ITEM BE REFERRED BACK TO THE DEPARTMENT. 28. 

SUP. MOLINA, CHAIR: OKAY. NOTING THAT EXCEPTION, ON THE REMAINDER, MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ON PAGE 19, SHERIFF, ITEMS 44 THROUGH 47. ON ITEM NUMBER 44, THE SHERIFF REQUESTS A ONE-WEEK CONTINUANCE. 

SUP. MOLINA, CHAIR: ALL RIGHT. ON THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. MISCELLANEOUS COMMUNICATIONS, ITEMS 48 THROUGH 57. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCES FOR INTRODUCTION, ITEMS 58 THROUGH 61 AND I'LL READ THE SHORT TITLE INTO THE RECORD. 58: AN ORDINANCE AMENDING TITLE 2, ADMINISTRATION OF THE LOS ANGELES COUNTY CODE RELATING TO THE BEACH COMMISSION BY EXTENDING THE SUNSET REVIEW DATE FOR THE COMMISSION TO DECEMBER 31, 2009. 59: AN ORDINANCE AMENDING TITLE 5, PERSONNEL AND TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE RELATING TO LIFEGUARDS. 60: AN ORDINANCE AMENDING SECTIONS 21.40.040 AND 21.40.080 OF TITLE 21, SUBDIVISIONS OF THE LOS ANGELES COUNTY CODE TO REQUIRE THAT GEOLOGY AND SOILS REPORTS SUBMITTED IN CONNECTION WITH THE TENTATIVE SUBDIVISION MAPS BE IN ELECTRONIC FORMAT IN ADDITION TO HARD COPY FORMAT. ALSO, MADAM CHAIR, ON 61, WE'RE GOING TO INTRODUCE THE-- WAIVE READING AND SET JULY 26TH, 2005, AT 9:30 A.M. FOR HEARING AND THAT'S 61, AN ORDINANCE AMENDING TITLE 27, ELECTRICAL CODE OF THE LOS ANGELES COUNTY CODE BY DELETING PORTIONS OF THE CALIFORNIA ELECTRICAL CODE 2001 EDITION WHICH HAS BEEN INCLUDED BY REFERENCE AND BY ADOPTING PORTIONS OF THE CALIFORNIA ELECTRICAL CODE 2004 EDITION, BY REFERENCE WITH CERTAIN CHANGES AND MODIFICATIONS AND MAKING OTHER REVISIONS THERETO. THOSE ITEMS ARE BEFORE YOU. 

SUP. MOLINA, CHAIR: ALL RIGHT. MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCES FOR ADOPTION, ITEMS 62 THROUGH 64. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: SEPARATE MATTERS, ITEMS 65 THROUGH 69. ITEM 65 IS BEFORE YOU FOR APPROVAL. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

SUP. KNABE: EXCUSE ME. MADAM CHAIR, ON ITEM 62, I THINK I WAS TO BE RECORDED AS A "NO" VOTE. 

SUP. MOLINA, CHAIR: 62? 

SUP. KNABE: YES. 

SUP. MOLINA, CHAIR: ON THE ORDINANCE? 

CLERK VARONA-LUKENS: OKAY. 

SUP. MOLINA, CHAIR: ALL RIGHT. THEN WE'LL ASK FOR RECONSIDERATION OF ITEM NUMBER 62. MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. AND THE ITEM IS BEFORE US. IT'S MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR ANTONOVICH. WE PUT ON THE RECORD THAT SUPERVISOR KNABE IS VOTING "NO." SO ORDERED ON THAT ITEM. 

CLERK VARONA-LUKENS: SO WE'LL GO TO ITEM 66 AND WE'LL HOLD THIS FOR A REPORT. ON ITEM 67, WE HAVE THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION PROVIDING FOR THE BORROWING OF FUNDS IN THE NAME OF THE ABC UNIFIED SCHOOL DISTRICT FOR FISCAL YEAR 2005/2006 AND THE ISSUANCE AND SALE OF 2005 TAX AND REVENUE ANTICIPATION NOTES IN PRINCIPAL AMOUNT NOT TO EXCEED $15 MILLION. THAT ITEM IS BEFORE YOU. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: 68, TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF LOS ANGELES UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS, ELECTION 2004, SERIES E, 2005, IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $900 MILLION. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AND 69, TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF MONTEBELLO UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS, ELECTION 2004, SERIES 2005, IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $30 MILLION. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: MISCELLANEOUS, ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE OFFICER WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA. ITEM 70-A. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: 70-B. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AND THAT COMPLETES THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 3. 

SUP. MOLINA, CHAIR: THIS MORNING, IT IS MY HONOR TO WELCOME TO LOS ANGELES COUNTY LOS ANGELES-- THE UNITED KINGDOM'S NEW CONSUL-GENERAL, THE HONORABLE BOB PIERCE. COUNSEL-GENERAL PEIRCE WAS ACCREDITED BY THE U.S. DEPARTMENT ON JUNE THE 27TH OF THIS LAST YEAR. PRIOR TO BECOMING CONSUL-GENERAL IN LOS ANGELES, COUNSEL-GENERAL PEIRCE WAS THE COUNSELOR AT THE BRITISH EMBASSY IN WASHINGTON, WHERE HE WAS RESPONSIBLE FOR POLITICAL AS WELL AS PUBLIC AFFAIRS. HE JOINED THE BRITISH DIPLOMATIC SERVICE IN 1977 AND HAS SERVED IN CHINA, HONG KONG, AND THE UNITED NATIONS IN NEW YORK. HE WAS A PRIVATE SECRETARY TO THREE BRITISH FOREIGN SECRETARIES AND HAS BEEN SECONDED TWICE TO THE HONG KONG EXTERNAL AFFAIRS UNDER GOVERNOR CHRIS PATTEN FROM 1993 TO 1997. WE ARE PLEASED TO WELCOME YOU TO L.A. COUNTY AND WE HOPE THAT YOU ENJOY LIVING HERE IN SOUTHERN CALIFORNIA. WE'D LIKE TO PRESENT THIS PLAQUE AS A WELCOME GIFT TO YOU AND WE LOOK FORWARD TO WORKING WITH YOU HERE AT THE COUNTY BOARD OF SUPERVISORS AND WE WANT TO EXTEND WHATEVER HELP WE CAN PROVIDE IN ORDER TO HAVE A GOOD RELATIONSHIP WITH YOUR COUNTRY. 

THE HONORABLE BOB PEIRCE: THANK YOU. [ APPLAUSE ] 

THE HONORABLE BOB PEIRCE: THANK YOU, MADAM CHAIR. I'D LIKE TO THANK YOU AND THE BOARD FOR THIS VERY WARM WELCOME AND THIS PLAQUE. I HAVE WHAT I CONSIDER TO BE THE BEST JOB THAT MY FOREIGN SERVICE HAS TO OFFER. THE CONSULATE-GENERAL THAT WE HAVE HERE IN LOS ANGELES IS LARGER THAN MANY OF OUR EMBASSIES AROUND THE WORLD AND BRITISH INTERESTS IN THIS AREA ARE MORE EXTENSIVE THAN IN MOST COUNTRIES OF THE WORLD. BRITAIN IS, FOR EXAMPLE, THE LARGEST INVESTOR HERE IN CALIFORNIA. IT'S NOT JUST ABOUT BUSINESS, THOUGH. FOR US, IT'S VERY MUCH ABOUT IDEAS IN THIS PART OF THE WORLD. I THINK LOS ANGELES IS A WONDERFUL WORLD CAPITAL FOR IDEAS. I, IN MY CAPACITY IN WASHINGTON, WAS IN THE BUSINESS OF SHARING BEST PRACTICE IN PUBLIC POLICY AND I FOUND THAT COUNTY AND CITY GOVERNMENTS WERE GENERALLY THE BEST INTERLOCUTORS WHEN IT CAME TO INNOVATION AT THAT LEVEL. HERE IN CALIFORNIA, THOSE INNOVATIONS WOULD RANGE FROM CRIMINAL JUSTICE TO CLIMATE CHANGE. CLIMATE CHANGE, I KNOW, IS A VERY BIG ISSUE FOR YOU HERE IN CALIFORNIA, IT'S A VERY BIG ISSUE FOR US. TOMORROW, WE ARE OPENING THE G-8 MEETING SUMMIT IN SCOTLAND, WHERE CLIMATE CHANGE IS ONE OF THE TWO BIG ISSUES, THE OTHER BEING AFRICA. AND AS WELL AS ASSUMING THE PRESIDENCY OF THE G-8, WE NOW HAVE THE PRESIDENCY OF THE EUROPEAN UNION, SO IT IS AN EXTREMELY INTERESTING TIME FOR ME TO BE TAKING UP THIS JOB. I'M REALLY LOOKING FORWARD TO IT AND I'M LOOKING FORWARD TO FURTHER DEVELOPING THE WONDERFUL RELATIONSHIP WE HAVE WITH THE MOST IMPORTANT COUNTY IN THE UNITED STATES. THANK YOU. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: LET ME INTRODUCE YOU TO MY COLLEAGUES. SUPERVISOR ANTONOVICH. SUPERVISOR ANTONOVICH, YOUR PRESENTATIONS. 

SUP. ANTONOVICH: WELL, THIS AFTERNOON, WE WOULD LIKE TO RECOGNIZE A GOOD FRIEND OF OURS. FOR A NUMBER OF YEARS, I'VE HAD THE OPPORTUNITY REPRESENTING THE ANTELOPE VALLEY, A GOOD FRIEND OF MINE AND MY FAMILY, AND THAT'S BISHOP HENRY HEARNS, WHO RECENTLY CELEBRATED HIS 40TH-YEAR ANNIVERSARY AS A PASTOR OF FIRST MISSIONARY BAPTIST CHURCH IN LITTLE ROCK. HE'S BEEN WITH THAT CHURCH SINCE HE CAME TO THE ANTELOPE VALLEY BACK 40 YEARS AGO, IN 1965 AND WAS THERE ORDAINED AS A PASTOR AND, LATER, JUST A COUPLE YEARS AGO, HE WAS ORDAINED AS THE BISHOP. IN ADDITION TO HIS RESPONSIBILITIES, WE ALL KNOW THE BISHOP AS THE VICE MAYOR FOR THE CITY OF LANCASTER, WHERE HE'S HAD THE OPPORTUNITY TO REPRESENT THEM SINCE 1990 AND HAS BEEN REELECTED FOUR TIMES TO SERVE THAT GREAT CITY OF LANCASTER IN THE ANTELOPE VALLEY. HE'S A VETERAN OF THE UNITED STATES ARMY, WHERE HE SERVED IN KOREA. HE HOLDS A BACHELOR'S OF SCIENCE DEGREE, BOTH IN AGRICULTURAL AND CIVIL ENGINEERING FROM TENNESSEE STATE UNIVERSITY AND HAS A MASTER OF SCIENCES IN ENVIRONMENTAL ENGINEERING FROM THE UNIVERSITY OF SOUTHERN CALIFORNIA. HE'S AN ACTIVE MEMBER OF THE ANTELOPE VALLEY COMMUNITY AND WE WORKED TOGETHER ON NUMEROUS PROJECTS, INCLUDING THE NEW ANTELOPE VALLEY ENVIRONMENTAL COLLECTION CENTER, WHICH IS A PERMANENT HAZARDOUS WASTE COLLECTION FACILITY, THE NEW WATERWORKS DISTRICT AND ANTELOPE VALLEY HEADQUARTERS, THE HIGH DESERT MULTI-SERVICE AMBULATORY CARE CENTER, THE ANTELOPE VALLEY HOPE CENTER FOR PEOPLE SUFFERING FROM H.I.V./A.I.D.S. BISHOP HEARNS ALSO SERVES ON THE BOARDS OF THE ANTELOPE VALLEY AIR QUALITY MANAGEMENT DISTRICT, THE ANTELOPE VALLEY TRANSIT AUTHORITY, THE ANTELOPE VALLEY HUMAN RELATIONS-- RELATIONS TASK FORCE, THE PUBLIC SAFETY COMMITTEE, THE ANTELOPE VALLEY HOMELESS COALITION AND THE REGENT BODY OF THE CALIFORNIA REGIONAL WATER QUALITY CONTROL BOARD. IN ADDITION, HE SERVES AS AN ALTERNATE ON THE SANITATION DISTRICT EDUCATION TO WORK COLLABORATIVE DESERT MOUNTAIN DIVISION OF THE LEAGUE OF CALIFORNIA CITIES AND THE SOUTHERN CALIFORNIA ASSOCIATION OF GOVERNMENTS. A MEMBER OF THE AMERICAN CANCER SOCIETY AND THE CALIFORNIA CONTRACT CITIES ASSOCIATION AND THE ORGANIZER OF THE YOUTH COMMISSION AND SERVES ON ADVISORY BOARDS FOR CHILDREN'S CENTER, THE BLACK INFANT HEALTH, UNITED WAY ANTELOPE MINISTERIAL ASSOCIATION AND THE BOY SCOUTS OF AMERICA. HE ORIGINATED THE MAYOR'S PRAYER BREAKFAST AND CONTINUES WITH THAT COMMITTEE AS WELL. HE HAS SIX CHILDREN AND THREE GRANDCHILDREN AND ONE OF THOSE IS WITH US THIS MORNING WITH THE HONORABLE HENRY HEARNS, AND THAT'S AVRIAL FULLER, WHO IS A GRADUATE OF THE UNIVERSITY OF CALIFORNIA RIVERSIDE AND IS NOW PURSUING A MASTER'S DEGREE AT CALIFORNIA STATE UNIVERSITY AT SAN BERNARDINO. SO, HENRY, CONGRATULATIONS FOR YOUR GREAT SERVICE, BOTH IN THE PULPIT AND IN THE ELECTED FIELD AS VICE MAYOR OF OUR GREAT CITY OF LANCASTER. [ APPLAUSE ] 

BISHOP HENRY HEARNS: I WOULD LOVE TO. HONORABLE SUPERVISOR, AND TO OUR CHAIR LADY AND ALL OF YOU, IT IS AN HONOR TO BE HERE TODAY. I AM SO THANKFUL TO BE A PART OF THE COMMUNITY, THE ANTELOPE VALLEY, AND TO WORK WITH A SUPERVISOR WHO NOT ONLY JUST DO POLITICAL THINGS BUT HE DOES THINGS THAT MAKES OUR COMMUNITY TO BE THE BEST IT CAN BE. SO, MIKE, I REALLY APPRECIATE IT AND WANT YOU TO KNOW THAT ANYTHING THAT WE CAN DO IN OUR VALLEY TO MAKE THINGS EASIER FOR YOU TO DO THEM, I'D BE GLAD TO DO THAT. I GUESS THE ONE THING I'D LIKE TO SAY IS THAT I'M GLAD TO BE AN AMERICAN, I'M GLAD THAT I HAD AN OPPORTUNITY TO SERVE IN KOREA AND I WANT TO SAY TODAY THAT I KNOW, WITHOUT A DOUBT IN MY MIND, THAT GOD LOVES AMERICA AND I KNOW HE'S GOING TO PROTECT US. GOD BLESS YOU AND THANK YOU SO VERY MUCH. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE WOULD LIKE TO RECOGNIZE DR. DIANA RAMOS FOR HER TWO YEARS OF SERVICE AS MY APPOINTEE TO THE LOS ANGELES COUNTY PUBLIC HEALTH COMMISSION. THAT WAS FROM 2003 TO JUNE OF THIS PAST MONTH. DR. RAMOS ATTENDED MEDICAL SCHOOL AT THE UNIVERSITY OF SOUTHERN CALIFORNIA WHERE SHE RECEIVED HER MASTER'S IN PUBLIC HEALTH FROM THE UNIVERSITY OF CALIFORNIA LOS ANGELES. SHE'S COMPLETED A FELLOWSHIP IN WOMEN'S HEALTH AT VETERAN'S HOSPITAL, A MEMBER OF THE LOS ANGELES COUNTY MEDICAL ASSOCIATION, THE AMERICAN PUBLIC HEALTH ASSOCIATION, THE AMERICAN MEDICAL ASSOCIATION, AMERICAN COLLEGE OF OBSTETRICS AND ECOLOGY AND CALIFORNIA MEDICAL ASSOCIATION AND THE AMERICAN SOCIETY OF REPRODUCTIVE MEDICINE. SHE'S MEMBERS OF THE PUBLIC HEALTH COMMISSION STUDY ADVISE WHERE THE MEMBERS I SHOULD SAY MAKE RECOMMENDATIONS ON MATTERS OF PUBLIC HEALTH UNDER THE JURISDICTION OF OUR COUNTY, INCLUDING THOSE MATTERS WITHIN THE CITIES IN LOS ANGELES COUNTY WHICH ARE UNDER THE JURISDICTION OF THE DEPARTMENT OF HEALTH. SO WE WANT TO THANK YOU FOR YOUR TWO YEARS OF SERVICE AND WISH YOU CONTINUED SUCCESS. IT WAS GREAT WORKING WITH YOU, DIANA. [ APPLAUSE ] 

DR. DIANA RAMOS: THANK YOU, SUPERVISOR ANTONOVICH, FOR THIS GREAT OPPORTUNITY OF SERVED FOR YOU AND REST AND REMIND FOR BEING INSTRUMENTAL IN INTRODUCING ME TO THE POSITION. I LEARNED A LOT AND, AS YOU KNOW, I WILL BE MOVING ON TO WORKING FOR THE COUNTY FULL- TIME AS MEDICAL DIRECTOR FOR MATERNAL, CHILD AND ADOLESCENT HEALTH, SO I LOOK FORWARD TO CONTINUING WORK. 

SUP. ANTONOVICH: OKAY. [ APPLAUSE ] 

SUP. ANTONOVICH: AND NOW WE HAVE LITTLE HARLEY, WHO IS A 12-WEEK-OLD LAB MIX WHO IS LOOKING FOR A HOME. THIS IS LITTLE HARLEY WITHOUT THE MOTORCYCLE. HI, HARLEY! SO, ANYBODY WHO IS WATCHING CAN CALL THE TELEPHONE NUMBER AT THE BOTTOM OF YOUR TELEVISION SCREEN, (562) 728-4644, FOR LITTLE HARLEY OR ANYBODY IN THE AUDIENCE THAT WOULD LIKE TO BE HARLEY'S MOTHER OR FATHER. OKAY? OKAY, BUDDY? 

SUP. KNABE: WHAT'S GOING ON, HARLEY? HUH, BUD? 

SUP. ANTONOVICH: HARLEY JUST TAKES IT EASY. 

SUP. KNABE: YEAH, UNTIL HE GROWS UP. 

SUP. MOLINA, CHAIR: THANK YOU, SUPERVISOR ANTONOVICH. WE'RE PLEASED TODAY TO WELCOME S.E.I.U. LOCAL PRESIDENT, ALEJANDRO STEVENS. WE WANT TO RECOGNIZE THE 12TH ANNUAL KEEP LOS ANGELES RUNNING 5-K THAT IS GOING TO BE TAKING PLACE THIS COMING SUNDAY, JULY 10TH, AS WE DECLARE THIS KEEP L.A. RUNNING DAY THROUGHOUT LOS ANGELES COUNTY. OVER THE LAST 12 YEARS, THIS EVENT HAS BEEN ONE OF THE MOST POPULAR DISTANCE RUNNING EVENTS IN SOUTHERN CALIFORNIA AND IT'S RAISED OVER $600,000 FOR VARIOUS CHARITIES. AFTER NINE YEARS IN PLAYA VISTA AND TWO YEARS IN EL SEGUNDO, THIS YEAR'S EVENT WILL BE HELD IN DOWNTOWN LOS ANGELES WITH A START AT OUR OWN HISTORIC L.A. MEMORIAL COLISEUM. THIS WORTHWHILE EVENT RAISES FUNDS FOR THE AMERICAN CANCER SOCIETY, THE BREAST OVARIAN CANCER NATIONAL ALLIANCE AND THE ROSA PARKS NEONATAL INTENSIVE CARE UNIT AT MARTIN LUTHER KING MEDICAL FACILITY AND OUR OWN COUNTY SPECIAL DISTRICT EMPLOYEES DISASTER RELIEF FUND. IT ALSO BENEFITS THE PEDIATRIC ONCOLOGY SERVICE, THE WOMEN AND CHILDREN'S HOSPITAL AT L.A. COUNTY U.S.C. MEDICAL CENTER AS WELL. WE'RE FORTUNATE TODAY THAT SEVERAL OF THE HOSPITAL PATIENTS ARE WITH US HERE TODAY, ASHLEY AND AMBER WELLGREY RIGHT HERE. AND THEIR MOTHER, LUCY CERVANTES; ANDRES MEDINA AND HIS MOTHER, MARIA MEDINA HERE; ALL RIGHT AND MARILYN MARIO, ACCOMPANIED BY RAFAELA CHEVALIER NESBITT, WHO IS THE DIRECTOR OF OUR CHILD LIFE PROGRAM AT L.A. COUNTY U.S.C. WOMEN AND CHILDREN'S HOSPITAL THAT WE'RE VERY PROUD OF. WE'RE VERY PROUD THAT THIS YEAR'S EVENT IS BEING HELD IN L.A. AND WE LOOK FORWARD TO A COUNTY STRONG PARTNERSHIP WITH S.E.I.U., BECAUSE WE WANT THIS EVENT TO BE A GREAT SUCCESS. MY OWN STAFF HAS PUT TOGETHER A RUNNING TEAM AND SO WE'RE GOING TO GO OUT THERE AND TRY OUR BEST. [ APPLAUSE ] I SHOULD BE ONE OF THE RUNNERS BUT I'M NOT, THOUGH I'M GOING TO BE THERE CHEERING ON THE TEAM. SO WE'RE VERY PROUD OF THE WORK THAT S.E.I.U. HAS BEEN DOING NOW FOR 12 YEARS AND I WANT TO MAKE A PRESENTATION TO ALEJANDRO, THE PRESIDENT OF S.E.I.U., FOR THE GREAT WORK THAT THEY'RE DOING AND THE GREAT BENEFIT THAT THEY BRING TO L.A. COUNTY. ALEJANDRO, CONGRATULATIONS. 

ALEJANDRO STEVENS: THANK YOU VERY MUCH, SUPERVISOR. 

SUP. MOLINA, CHAIR: PLEASE JOIN US AND SAY A FEW WORDS. 

ALEJANDRO STEVENS: I'M REALLY HONORED AND HUMBLED BY THIS PRESENTATION ACKNOWLEDGEMENT OF THE EVENTS THAT WE HAVE BEEN CONDUCTING FOR THE LAST 12 YEARS. BUT I ALSO WANT TO SAY SPECIAL THANKS TO THE SUPERVISORS FOR REALLY GOING OUT OF THEIR WAY AND SUPPORTING THIS EVENT BECAUSE THIS EVENT BENEFITS COUNTY EMPLOYEES. IT ALSO BENEFITS ALL OF THE CHARITIES THAT WE MENTIONED BEFORE. SO ON BEHALF OF THE COMMITTEE OF THE EMERGENCY RELIEF FUND FOR S.E.I.U. LOCAL 660, WE WANT TO THANK YOU VERY MUCH FOR YOUR SUPPORT, NOT ONLY THIS YEAR, BUT IN THE COMING YEARS. WE LOOK FORWARD TO REALLY PARTNERING WITH YOU AND MAKING THIS EVENT A PREMIER EVENT IN THE CITY OF LOS ANGELES. THANK YOU VERY MUCH. [ APPLAUSE ] 

ALEJANDRO STEVENS: OH, WE ALSO HAVE T-SHIRTS FOR EACH OF THE SUPERVISORS. 

SUP. MOLINA, CHAIR: WHAT TIME DO YOU WANT THEM TO SHOW UP ON SUNDAY? 

ALEJANDRO STEVENS: OH, YES. WE HAVE A COMMITMENT FROM SUPERVISOR YAROSLAVSKY. HE IS REALLY ONE OF THE PREMIER RUNNERS, RIGHT? 

SUP. MOLINA, CHAIR: YES. 

SUP. YAROSLAVSKY: HUH! [ LAUGHTER ] 

ALEJANDRO STEVENS: ALONG WITH SHERIFF BACA AND MANY OTHERS FROM THE COUNTY WHO REALLY ATTEND. THE SUPERVISOR'S GONNA BE WALKING THIS YEAR, I UNDERSTAND, RIGHT SUPERVISOR? GREAT. SHE HAS A TEAM TOGETHER. SUPERVISOR KNABE, YOU'RE GOING TO COMING UP AND HOPEFULLY WE CAN GET SUPERVISOR ANTONOVICH AND SUPERVISOR BURKE IS GONNA BE THERE SO WE CAN HAND THIS TO HER. AGAIN, WE WOULD LIKE TO HAVE RAFAELA CHEVALIER NESBITT SAY A FEW WORDS ABOUT HER PROGRAM, CHILD LIFE. 

SUP. MOLINA, CHAIR: THANK YOU. 

RAFAELA CHEVALIER NESBITT: THE CHILD LIFE PROVIDES PSYCHO SOCIAL SUPPORT TO PEDIATRIC PATIENTS. WE PROVIDE PSYCHOLOGICAL PREPARATION WHEN THEY'RE GETTING POKES OR GOING TO THE O.R., ESPECIALLY OUR ONCOLOGY PARENTS. THEY'RE AWESOME. YOU SHOULD SEE THEM. YOU SHOULD COME OVER, MS. MOLINA, AND SEE THEM. THEY'RE JUST INSPIRATIONAL. BUT THE FUNDING DOES NOT JUST COME TO PEDIATRIC ONCOLOGY, IT BENEFITS ALL THE PATIENTS AT COUNTY U.S.C. MEDICAL CENTER, THE PEDIATRIC PATIENTS, YOU KNOW, BECAUSE WE HAVE KIDS UP IN THE BURN WARD, WE HAVE NEUROMED AND THIS IS SO IMPORTANT. WE'RE SO THANKFUL AND APPRECIATIVE OF THIS FUNDING BECAUSE WE'RE ABLE TO DO MEMORIAL SERVICES AND BIRTHDAY CELEBRATIONS ET CETERA, ET CETERA AS NEEDED. THANK YOU. 

SUP. MOLINA, CHAIR: THAT CONCLUDES THIS MORNING'S PRESENTATIONS. WE'RE GOING TO BEGIN WITH SUPERVISOR ANTONOVICH'S PRESENTATIONS-- SPECIALS. MR. JANSSEN, I THINK IT WOULD BE A GOOD TIME NOW IF WE ASKED-- I DON'T KNOW IF OUR AUDITOR IS HERE. OH, GOOD. 

C.A.O. JANSSEN: YES, HE'S HERE. 

SUP. MOLINA, CHAIR: I'M GOING TO ASK THE AUDITOR TO COME UP AND JOIN US AND WE CAN, AS IT'S MY UNDERSTANDING, UNDER AGENDA ITEM NUMBER 71, WE WANTED TO HAVE AN OPPORTUNITY TO HEAR FROM TYLER MCCAULEY OF THE IMPLEMENTATION OF OUR E-CAPS PROGRAM. I THINK THIS IS WORTHWHILE THAT WE KNOW THE KIND OF SUCCESSES THAT WE'VE BEEN HAVING ON A VERY COMPLEX AND INTEGRATED PROGRAM THAT'S GOING TO GO A LONG WAY TO MAKE US MORE EFFICIENT. SO IF YOU GIVE US A BRIEF PRESENTATION, WE WOULD APPRECIATE IT. 

J. TYLER MCCAULEY: THANK YOU, MADAM CHAIRMAN AND MEMBERS OF THE BOARD. I'M TYLER MCCAULEY, THE AUDITOR-CONTROLLER I'M VERY PLEASED TO BE ABLE TO TELL YOU THAT THE COUNTY'S NEW ACCOUNTING, DISBURSING, AND GENERAL LEDGER SYSTEM WENT UP AT THE END OF JUNE AND IT IS DOING VERY WELL. WE ARE EXPERIENCING WHAT I CONSIDER NORMAL PROCESSING PROBLEMS IN A NEW SYSTEM AS DEPARTMENTS GET USED TO USING IT. HOWEVER, THE SYSTEM ITSELF IS DOING WHAT IT WAS DESIGNED TO DO AND ACTUALLY A NUMBER OF THE PROBLEMS THAT ARE CREATED IS THE DEPARTMENTS ARE HAVING TO BE HELD TO THE STRUCTURE OF THE NEW SYSTEM AND, FOR EXAMPLE, ISSUE A VENDOR NUMBER OR THEIR P.O. WON'T BE PROCESSED AND A CONTRACT NUMBER OR THE CONTRACT WON'T GO THROUGH AND SO THOSE ARE THE TYPES OF ERRORS WE'RE FINDING. AND THERE ARE SOME OTHER MINOR ERRORS BUT WE'RE VERY PLEASED WHERE WE ARE TODAY. I DON'T KNOW IF YOU'RE AWARE BUT IN THE FIRST DAY OF EACH FISCAL YEAR, COUNTY HAS TO ISSUE A NUMBER OF VERY LARGE AND IMPORTANT EXPENDITURES FOR THINGS LIKE RENT AND AGREEMENTS WITH THE MEDICAL CENTER. WE RECEIVE THE TANS MONEY FROM THE BANK, SO IT'S A VERY-- THERE ARE A LOT OF VERY LARGE AND IMPORTANT PAYROLLS THAT HAVE TO BE DONE FOR WELFARE AND CHILDREN'S SERVICES, DIRECT DEPOSITS AND THE SYSTEM PERFORMED REALLY QUITE WELL. AGAIN, THE ERRORS THAT WERE NOTED WERE GENERALLY DUE TO BAD INFORMATION AND WE WERE ABLE TO QUICKLY TURN THOSE AROUND AND MAKE IT WORK. WE'RE VERY PLEASED THAT THE SYSTEM, AS YOU INDICATED, MADAM CHAIR, WILL EVENTUALLY BRING-- INCREASE ACCOUNTABILITY TO THE COUNTY OF LOS ANGELES IN TERMS OF THE NATURE OF OUR ACCOUNTING AND TRANSACTIONS AND IT WILL INCREASE DRAMATICALLY THE AMOUNT OF INFORMATION AVAILABLE TO YOUR BOARD TO EVALUATE DEPARTMENT PERFORMANCE AND TO DO PERFORMANCE COUNTS AND OTHER IMPORTANT PROGRAMS THAT WE ARE INVOLVED IN. SO WE'RE, AT THIS MOMENT, VERY PLEASED. I DO REGRETTABLY HAVE TO TELL YOU ABOUT-- IT'S NOT A SYSTEMS PROBLEM BUT I WAS JUST INFORMED THE BANK OF AMERICA INCORRECTLY PROCESSED ONE OF OUR PAYROLLS, THAT THEY THOUGHT IT WAS A TEST PAYROLL AND IT WAS A PRODUCTION PAYROLL AND 6,500, WELFARE RECIPIENTS, FOSTER PARENTS AND SO FORTH WEREN'T PAID WHERE THEY WERE EXPECTED AND THEY PRESENTED THEIR PAYMENT TO THE BANK. WE HAVE IMMEDIATELY WORKING WITH THE DEPARTMENT TO CORRECT THIS. IT WAS SIMPLY A HUMAN ERROR MADE BY SOMEONE AT THE BANK, AND THAT WAS NOT RELATED TO THE SYSTEM ITSELF. BUT, IF YOUR OFFICE RECEIVES CALLS, PLEASE KNOW THAT WE'RE WORKING VERY QUICKLY TO MAKE SURE THAT THOSE CHECKS ARE HONORED, HOPEFULLY BY THE END OF THE DAY. AND WHILE I'M HERE, I WOULD ALSO LIKE TO TELL YOU THAT, ON THE SAME DAY THAT THE NEW SYSTEM WENT UP, THE NEW COUNTY NEW SHARED SERVICES SYSTEM WENT UP. THIS IS A NEW AUDITOR-CONTROLLER FUNCTION WHERE WE ARE WORKING WITH 19 COUNTY DEPARTMENTS AND PERFORMING THEIR FISCAL OPERATIONS OR MOST OF THEIR FISCAL OPERATIONS. I CAN'T SAY YET HOW WELL IT WAS WORKING BECAUSE IT'S SO NEW BUT WE WERE ALL PREPARED AND THE STAFF TRAINED AND WE'RE WAITING TO RECEIVE THE FIRST TRANSACTIONS. SO I'D BE PLEASED TO ANSWER ANY QUESTIONS BUT, AT THIS MOMENT, THINGS LOOK VERY WELL AND I THANK SO MUCH MY COLLEAGUES IN MY DEPARTMENT, THE DEPARTMENT OF INTERNAL SERVICES DEPARTMENT, DAVE LAMBERTSON AND, IN PARTICULAR, THE C.G.I. A.M.S., OUR CONTRACTORS HAVE PERFORMED WONDERFULLY AS PARTNERS IN THIS AND HAVE DONE AN INCREDIBLE JOB AND PUT IN AN INCREDIBLE AMOUNT OF WORK TO ENSURE IT CAME IN ON TIME AND UNDER BUDGET. 

SUP. MOLINA, CHAIR: ALWAYS NICE UNDER BUDGET. ANY QUESTION OR COMMENT? I JUST WANTED TO ASK A QUICK QUESTION. HOW IS THE TRAINING GOING WITH ALL THE DEPARTMENTS? BECAUSE THEY HAVE TO TRANSFER ALL THEIR INFORMATION ONTO IT OR DID IT... 

J. TYLER MCCAULEY: THE TRAINING-- WE TRAINED ALL THE DEPARTMENTS. WE ACTUALLY TRAINED A LITTLE LESS THAN 3,000 EMPLOYEES, SUPERVISOR, AND WE ARE NOW IN THE PROCESS OF RETRAINING THOSE WHO ARE DOING-- OFFERING RETRAINING CLASSES. DEPARTMENTS HAVE TOLD US OF PEOPLE THEY WISH WERE TRAINED THE FIRST TIME AND THEY NOTIFIED US OF THAT, PLUS WE PLAN, DURING THIS MONTH, TO CONTINUE TO RETRAIN AND OFFER CLASSES IN DIFFERENT AREAS, AGAIN, TO ENSURE THAT THE SYSTEM PERFORMS WELL. 

SUP. MOLINA, CHAIR: AND CAN DEPARTMENTS ASK FOR DATA, I MEAN, FOR THEIR OWN DEPARTMENTS AND THEIR-- WHATEVER? IT CAN WORK FROM DEPARTMENT AS WELL AS COUNTYWIDE, RIGHT? 

J. TYLER MCCAULEY: CORRECT. IT'S AVAILABLE COUNTYWIDE AND IT'S AVAILABLE FOR EACH DEPARTMENT. THE CHARTER OF ACCOUNTS, IF YOU JUST THINK OF IT AS A NUMBER OF BUCKETS THAT THE DEPARTMENT PUTS THEIR EXPENDITURES IN, IT IS MUCH, MUCH MORE ROBUST THAN THE LAST ONE AND THEY'RE ABLE TO BOTH TELL YOU, IF YOU WOULD ASK ME HOW MANY PAYMENTS WE MAKE IN THIS TYPE OF PAYMENTS, WE CAN TELL YOU THAT. AND THAT WILL BE VERY HELPFUL, PARTICULARLY WHEN WE GET UP TO PURCHASING MODULE WHICH, BY THE WAY, STARTED TODAY. AND ALSO THE DEPARTMENTS THEMSELVES CAN USE IT TO MONITOR THEIR TRANSACTIONS, THEIR EXPENDITURES AND, IN PARTICULARLY, CONTRACTS, WHICH IS SOMETHING THAT HAS BEEN A DIFFICULT THING. THE SYSTEM REALLY IS A GOOD MANAGEMENT TOOL FOR CONTRACTORS. WE HAVE, WE BELIEVE, ALL THE CONTRACTS ON OUR SYSTEM. IF THEY INTRODUCE A NEW CONTRACT THAT WE DON'T KNOW ABOUT, THEY WILL NOT GET PAID. THE CONTRACT WILL. SO THAT IS FORCING DEPARTMENTS TO ENSURE THAT OUR CONTRACT FILE IS COMPLETE, AS IS OUR VENDOR FILE. SO I LOOK FORWARD, IN THE FUTURE, TO OFFERING TRAINING COURSES TO YOUR BOARD AND DEPUTIES AND ANY THAT WOULD LIKE TO SEE IT AND I WOULD ALSO-- GOING TO OFFER THEM TO MY COLLEAGUES, DEPARTMENT HEADS WHO, BY THE WAY, HAVE ALSO BEEN EXTREMELY COOPERATIVE IN THIS ENTIRE SYSTEM CHANGEOVER. 

SUP. MOLINA, CHAIR: AND, IN-- AS ALL OF THE DEPARTMENTS, IT'S MANDATORY, RIGHT, THAT THEY BE CONNECTED INTO THE...? 

J. TYLER MCCAULEY: OH, ABSOLUTELY. 

SUP. MOLINA, CHAIR: SO ALL OF THE HEALTH DEPARTMENT CONTRACTS ARE THROUGH THERE? 

J. TYLER MCCAULEY: THAT'S CORRECT. 

SUP. MOLINA, CHAIR: AS WELL AS ALL THE FIRE DEPARTMENT CONTRACTS ON THERE? 

J. TYLER MCCAULEY: CORRECT. 

SUP. MOLINA, CHAIR: AND SO THEY ALL HAVE THE TICKLER SYSTEMS AND ALL OF THAT SO THAT, IF THEY-- WE WON'T HAVE RETROACTIVE CONTRACTS ANY MORE? 

J. TYLER MCCAULEY: IT TURNED OUT THAT-- YES, THAT WAS WHY WE STARTED CONTRACT MONITORING; HOWEVER, YES, THEY DO, THEY GET REGULAR REPORTS AS MANY DAYS AHEAD AS THEY WANT, 120, 90, 60, 30. 

SUP. MOLINA, CHAIR: SO NOW THERE'S NO EXCUSES, RIGHT? 

J. TYLER MCCAULEY: I CAN'T THINK OF ONE, SUPERVISOR. IT WOULD BE HARD TO MISS ONE IN THIS PHASE. 

SUP. MOLINA, CHAIR: GOOD, WE CAN END RETROACTIVE CONTRACTS. OKAY. GOOD. ANY OTHER QUESTION OR COMMENT? IF NOT, THANK YOU SO MUCH. WE APPRECIATE. I'M GLAD THAT IT'S ON TIME AND UNDER BUDGET. WHAT ELSE CAN YOU ASK FOR? THANK YOU. APPRECIATE IT. ALL RIGHT. IF WE COULD MOVE ON TO OUR SPECIALS, SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: I'D LIKE TO MOVE THAT WE ADJOURN IN MEMORY OF... 

SUP. MOLINA, CHAIR: I'M SORRY? 

SUP. KNABE: I THINK ZEV'S FIRST. 

SUP. MOLINA, CHAIR: OH, I'M SORRY. I HAD ON HERE THAT-- I APOLOGIZE. 

SUP. YAROSLAVSKY: THAT'S ALL RIGHT. 

SUP. MOLINA, CHAIR: I'M SORRY. 

SUP. ANTONOVICH: WE'LL HOLD ON, ON STEVE FOR A MINUTE. 

SUP. YAROSLAVSKY: I HAVE ONE ADJOURNING MOTION AND THAT'S FOR STEVE BELL. I DON'T KNOW IF THAT'S THE ONE THAT MR. ANTONOVICH IS GOING TO DO BUT ANYWAY, STEVE BELL, WHO I THINK MANY OF US KNEW WAS AN INNOVATIVE AND WELL-RESPECTED FORMER LOCAL TELEVISION NEWS EXECUTIVE WHO SERVED AS THE EXECUTIVE DIRECTOR OF THE L.A. CAMPUS OF THE MUSEUM OF TELEVISION AND RADIO IN BEVERLY HILLS WHO RECENTLY DIED OF A HEART ATTACK AT THE AGE OF 66 IN PACIFIC PALISADES AT HIS HOME. HE'S SURVIVED BY HIS WIFE OF 35 YEARS, BERNICE, TWO CHILDREN, DAVID AND ELIZABETH AND A BROTHER, ALAN. STEVE WAS A NEWS PRODUCER, I THINK, AT CHANNEL 5, IS THAT RIGHT? K.T.L.A. THAT'S WHERE I FIRST GOT TO KNOW HIM AND WAS REALLY A FIXTURE AND HELPED SHAPE THE WAY NEWS, IN THE HEYDAY OF NEWS, WHEN WE REALLY HAD NEWS, ON LOCAL NEWS, WAS DELIVERED AND HE'S-- HE WILL BE SORELY MISSED. THAT'S ALL I HAVE IN THE WAY OF ADJOURNING MOTIONS, MADAM CHAIR. 

SUP. MOLINA, CHAIR: ALL RIGHT. ANY OTHER ITEMS? 

SUP. YAROSLAVSKY: I'M NOT HOLDING ANYTHING. 

SUP. MOLINA, CHAIR: ALL RIGHT. VERY GOOD. THANK YOU. SUPERVISOR KNABE, YOUR SPECIALS. 

SUP. KNABE: THANK YOU, MADAM CHAIR. FIRST OF ALL, I MOVE TODAY THAT WE ADJOURN IN MEMORY OF "D.A." MCCLAIN. AND "D.A." PASSED AWAY ON WEDNESDAY, JUNE 28TH, AT THE AGE OF 43 AT HER HOME IN ARCADIA AFTER A LONG BATTLE, A VALIANT FIGHT AGAINST CANCER. AS WE ALL KNOW, "D.A." SERVED AS M.T.A. BOARD OF TRANSPORTATION DEPUTY TO FORMER M.T.A. BOARD MEMBER BEA PROO. SHE BEGAN HER CAREER WITH THE R.T.D. IN 1991 AS A PUBLIC AFFAIRS REPRESENTATIVE. SHE BECAME AN ADMINISTRATIVE ANALYST IN 1995 AND WAS APPOINTED BOARD TRANSPORTATION DEPUTY IN JULY OF 2000. 

SUP. BURKE: I'D LIKE TO JOIN IN THAT. 

SUP. KNABE: I THINK ALL MEMBERS. SHE WAS A DEDICATED AND TIRELESS WORKER WHO WILL BE MISSED BY HER FRIENDS AND COLLEAGUES. SHE'S JUST A GREAT LADY. SHE IS SURVIVED BY HER SON, HUSSEIN, DAUGHTER, MCKENZIE, BROTHER VICTOR, BROTHER, MICHAEL AND BROTHER, THOMAS. SHE WILL BE MISSED. GREAT GAL, GREAT FIGHT, GREAT SMILE, ALL THE WAY UP TO THE END. 

SUP. MOLINA, CHAIR: SWEET LADY. 

SUP. KNABE: ALSO THAT WE ADJOURN IN MEMORY OF "BARNEY" SCHWARTZ WHO PASSED AWAY AT THE AGE OF 80. HE WAS VERY INVOLVED IN HIS NEIGHBORHOOD BACK IN PENNSYLVANIA. HE ENJOYED POLITICS, PLAYING GOLF AND LOVED FOLLOWING THE STEELERS AND THE PIRATES AND I THINK ALL MEMBERS IN THIS AS WELL. HE'S SURVIVED BY HIS WIFE, ROSLYN, DAUGHTERS, SARALEE, AND GLORIA, GRANDCHILDREN ELIZABETH AND JONATHAN, AND HIS SONS-IN-LAW, DAVID AND REGGIE TODD, OUR WASHINGTON, D.C. LEGISLATIVE REPRESENTATIVES. ALL MEMBERS ON BARNIE SCHWARTZ. ALSO THAT WE ADJOURN IN MEMORY OF PENNY SOHIKIAN, WHOI PASSED AWAY AT THE AGE OF 93 AFTER A LONG BATTLE WITH ALZHEIMER'S. HE'LL BE SORELY MISSED BY FAMILY AND FRIENDS, SURVIVED BY HIS WIFE, RUBY, TWO SONS, ARTHUR AND JOHN AND THREE GRANDCHILDREN, LAUREN, AUDREY, AND ANDREW. AND ALSO THAT WE ADJOURN IN THE MEMORY OF MARK GASSMAN. MANY OF YOU KNOW MARK FOR HIS INVOLVEMENT WITH FIREWORKS COMPANIES BUT, AS THEY PREPARED FOR THIS HOLIDAY SEASON, HE WAS HELPING TO UNLOAD A TRUCK AND HAD A MAJOR HEART ATTACK AND PASSED AWAY AT THE AGE OF 62. HE WAS A ASSOCIATE OF TNT FIREWORKS FOR OVER 25 YEARS AND A GREAT FRIEND TO MANY OF US AND TO THE CALIFORNIA CONTRACT CITIES ASSOCIATION. HE IS SURVIVED BY HIS WIFE OF 17 YEARS, CATHY, A HOST OF FRIENDS AND EXTENDED FAMILY MEMBERS. ALSO ADJOURN IN MEMORY OF MR. BOB MEYER. BOB WAS A GRADUATE OF CAL POLY. HE HAD BEEN A SUPERINTENDENT OF PARKS FOR THE CITY OF CERRITOS FOR SOME 34 YEARS PRIOR TO HIS RETIREMENT IN 2000. HE WAS ALSO MEMBER OF THE CERRITOS OPTIMIST CLUB. HE IS SURVIVED BY HIS WIFE, JO ANN, DAUGHTERS DONNA, DEBBIE, DIANE, MOTHER-IN-LAW, BETTY, NEPHEWS, JIM, ERIC, SIX GRANDCHILDREN. HE'LL BE MISSED BY FAMILY AND FRIENDS. ALSO FINALLY THAT WE ADJOURN IN MEMORY OF TONI LA VOY, WHO PASSED AWAY ON JUNE 27TH AT THE AGE OF 79, A 50 YEAR RESIDENT OF THE CITY OF LAKEWOOD AND VERY ACTIVE IN THE LADY ELKS AND LAKEWOOD WOMEN'S CLUB AND ST. BERNARD'S PARISH. SHE IS SURVIVED BY HER HUSBAND OF 52 YEARS, HOWARD, HER SON, GARY, HER DAUGHTERS, PAT, A STEPDAUGHTER, JULIE, BROTHER, CARL, SISTER, ROSE, SEVEN GRANDCHILDREN AND ONE GREAT GRANDDAUGHTER. THOSE ARE MY ADJOURNMENTS, MADAM CHAIR. 

SUP. MOLINA, CHAIR: SO ORDERED ON THOSE ADJOURNMENTS. 

SUP. KNABE: I'M NOT HOLDING ANYTHING. 

SUP. MOLINA, CHAIR: ALL RIGHT. SUPERVISOR ANTONOVICH, YOUR SPECIALS. 

SUP. ANTONOVICH: MOVE THAT WE ADJOURN IN MEMORY OF STEVE BELL THAT ZEV JUST MENTIONED. ONE OF HIS CREATIONS BACK IN 1991 WAS THE MORNING NEWS FORMAT, WHICH BECAME AN AWARD- WINNING FORMAT OF EARLY NEWS. THAT WAS THE K.T.L.A. MORNING NEWS. HE WENT BACK TO K.T.L.A. BACK IN 1981 AND HE HELPED WITH THEIR HIGH RATINGS WITH HAL FISHERMAN, LARRY MCCORMICK, STAN CHAMBERS AND THE WHOLE CREW DOING A SUPERB JOB AND ALSO ONE OF THE AWARD- WINNING NEWS PRESENTATIONS. ANTONIO MIRO, WHO WAS A 15-YEAR EMPLOYEE OF THE DEPARTMENT OF PUBLIC WORKS. HE WAS THE PRINCIPAL FACILITIES PROJECT MANAGER AND, OVER THE COURSE OF HIS CAREER, HE MANAGED NUMEROUS CAPITAL PROJECTS INCLUDING OUR EATON CANYON NATURE CENTER AND THE JACKIE ROBINSON PARK GYMNASIUM IN MY DISTRICT. HE WAS A MEMBER OF THE TEAM OF PROJECT MANAGERS RESPONSIBLE FOR THE NEW L.A. COUNTY-U.S.C. MEDICAL CENTER REPLACEMENT PROJECT. AND AGAIN, FOR "D.A." MCCLAIN. SHE WAS A FRIEND TO ALL OF US. SHE WAS A VERY SPECIAL PERSON. SHE HAD A VERY VALIANT FIGHT FOR CANCER AND WAS DOING SO WELL, AND THEN IT CAME BACK AGAIN AND SHE PASSED AWAY AT A VERY, VERY YOUNG AGE. CAPTAIN LILLIAN KEIL OF THE COVINA HILLS RETIRED FLIGHT NURSE, ONE OF THE MOST DECORATED WOMEN OF WORLD WAR II AND KOREA. SHE PASSED AWAY THIS PAST MONTH ON JUNE 30TH. DURING HER MILITARY CAREER, SHE FLEW A TOTAL OF 450 COMBAT MISSIONS, EARNING 19 MEDALS, INCLUDING FOUR AIR MEDALS, FOUR PRESIDENTIAL UNIT CITATIONS, THE KOREAN PRESIDENTIAL UNIT CITATION, 11 BATTLE STARS ON COMBAT AREA SERVICE MEDALS. ADDITIONALLY, HER LIFE WAS PORTRAYED IN THE MOVIE, THE 1953 MOVIE, "FLIGHT NURSE." SHE WAS QUITE ACTIVE WITH OUR COUNTY VETERANS ORGANIZATIONS UNTIL HER ILLNESS PRECEDING HER DEATH AND IT WAS A PLEASURE TO KNOW HER AND TO WORK WITH HER. EUPHRATES KAZANJIAN, PASSED AWAY AT THE AGE OF 100. SHE WAS QUITE ACTIVE IN THE COMMUNITY AND SHE LEAVES HER TWO CHILDREN, MICHAEL AND STANLEY. DR. MARY HARTSON. SHE WAS A MEDICAL PHYSICIAN, A DERMATOLOGIST, PRACTICED IN THE GLENDALE AREA FOR 40 YEARS. ANNY PARIS. SHE WAS-- FLED HUNGARY DURING WORLD WAR II, MARRIED AN AMERICAN SOLDIER WHO WAS STATIONED IN AUSTRIA AND WHO PASSED AWAY IN 1994, HER HUSBAND, MELVIN, AFTER 47 YEARS OF MARRIAGE. THEY HAD MOVED TO BURBANK IN 1955, AND THEN GLENDALE IN 1972. SHE WAS A ACTIVE MEMBER OF THE INCARNATION CHURCH IN GLENDALE AND ST. STEVEN HUNGARIAN CHURCH IN LOS ANGELES. JOHNNIE DEL LA CERDA PENALVER, SR. WHO SERVED IN THE UNITED STATES AIR FORCE DURING WORLD WAR II AND HIS MEDALS INCLUDED THE VICTORY MEDAL AND THE ARMY THEATRE CITATION. WARREN R. "TIPPY" TIMPSON, WHO WAS ACTIVE IN THE GLENDALE BURBANK COMMUNITY. HE WAS A ACTIVE MEMBER OF THE CHAMBER OF COMMERCE AND WAS A GOOD COMMUNITY LEADER. CORPORAL DION WHITLEY, WHO WAS FROM ALTADENA, WHO WAS KILLED THIS PAST MONTH IN IRAQ. HE IS SURVIVED BY HIS MOTHER, DEBORAH WHITLEY AND BROTHER, AARON WHITLEY. AND LEROY BOYD, RETIRED DEPUTY SHERIFF, WHO RETIRED IN MAY OF 1991. HIS LAST ASSIGNMENT WAS AT SPECIAL INVESTIGATIONS. 

SUP. MOLINA, CHAIR: SO ORDERED ON THOSE ADJOURNMENTS. 

SUP. ANTONOVICH: IS PAUL HIGA HERE FROM PROBATION? I WANT TO ASK HIM SOME QUESTIONS. 

SUP. MOLINA, CHAIR: ALL RIGHT. MR. HIGA? 

SUP. ANTONOVICH: GOOD AFTERNOON, PAUL. 

PAUL HIGA: GOOD AFTERNOON. 

SUP. ANTONOVICH: RELATIVE TO THE FACT OF THE REPORT THAT THERE ARE 4,000-- I SHOULD SAY WARRANTS OUT FOR 7,000 PAROLE VIOLATORS, HOW MANY IN LOS ANGELES COUNTY? HOW MANY PROBATIONERS ARE THERE IN OUR COUNTY? 

PAUL HIGA: SUPERVISOR, WE HAVE CURRENTLY 61,000 ADULTS THAT ARE ON PROBATION AND APPROXIMATELY 24,000 JUVENILES THAT ARE ON PROBATION. 

SUP. ANTONOVICH: AND HOW MANY OF THOSE ARE AT LARGE? 

PAUL HIGA: THAT'S A QUESTION THAT I DON'T HAVE AN ACCURATE ANSWER FOR. PART OF OUR PROBLEM IS THAT OUR CURRENT SYSTEM IS NOT DIRECTLY CONNECTED WITH THE COUNTYWIDE WARRANT SYSTEM, WHICH DOES HAVE THE MOST ACCURATE INFORMATION, SO WE END UP NEEDING TO DO AN INTERFACE WITH THEM TO GET AN ACCURATE INFORMATION. I CAN GET YOU THAT INFORMATION WITHIN A COUPLE OF WEEKS AND THAT IS AN AREA WHICH WE'RE CONTINUING TO WORK ON BECAUSE WARRANTS ARE AN AREA THAT WE'RE PRACTICALLY TRYING TO ENFORCE. 

SUP. ANTONOVICH: IF YOU REPORT BACK IN A COUPLE WEEKS, COULD YOU GIVE US PERHAPS A PROTOCOL THAT WE COULD INITIATE TO HAVE THOSE TWO SYSTEMS COMPATIBLE? 

PAUL HIGA: ABSOLUTELY. 

SUP. ANTONOVICH: DO OUR DISARM TEAMS WORK WITH PAROLE NOW? 

PAUL HIGA: YES. YOU KNOW, THE-- PROBABLY THE THREE MAIN FEATURES OF ANY KIND OF PROACTIVE PROGRAM IS, NUMBER ONE, COLLABORATION, WHICH IS THAT THE AGENCIES NEED TO COLLABORATE NOT JUST WITH LAW ENFORCEMENT BUT WITH COMMUNITIES, FAITH-BASED ORGANIZATIONS, MEMBERS OF THE COMMUNITY THEMSELVES AND SO THAT'S AN IMPORTANT PIECE. SO PAROLE CERTAINLY IS ONE OF THOSE PARTNERS THAT WE COLLABORATE WITH. THE SECONDS PIECE, WHICH I THINK IS REALLY EQUALLY AS IMPORTANT, IS CASE MANAGEMENT, THAT THE INFORMATION RELATIVE TO TARGETING CERTAIN PROBATIONERS OR PAROLEES SHOULD BE TRIGGERED BY CASE MANAGEMENT. IN OTHER WORDS, SOMEBODY THAT'S NOT COMPLYING WITH CERTAIN CONDITIONS SHOULD HEIGHTEN PEOPLE'S AWARENESS THAT THIS IS A PERSON OF HIGHER RISK. THE FINAL PIECE IS TACTICAL OPERATIONS, WHICH IS ENSURING THAT THE INFORMATION AND THE CRITICAL INFORMATION IS SHARED AMONG ALL KEY MEMBERS PRIOR TO ANY KIND OF TACTICAL OPERATION BEING IMPLEMENTED. YOU ALSO ASKED ABOUT PAROLE. I CAN GIVE YOU THREE EXAMPLES OF SOME OPERATIONS THAT WE HAVE COORDINATED WITH PAROLE, WITH DISARM OVER THE LAST COUPLE OF MONTHS. ONE WAS IN MAY WHERE DISARM NORTH AND CLEAR WERE TARGETING IN THE L.A.P.D. FOOTHILL DIVISION. DISARM SOUTH AND L.A.P.D. AND THE SOUTH BAY WAS ALSO TARGETING WITH PAROLE IN THAT AREA IN THE MONTH OF MAY. AND, IN JUNE, DISARM NORTH WAS ALSO WORKING WITH BURBANK P.D. WITH PAROLE TO TARGET VIOLATORS OF PROBATION AND PAROLE. 

SUP. ANTONOVICH: AND TALKING WITH THE SHERIFF'S DEPARTMENT, I WAS TOLD THAT THE CRIME DROPPED, WAS IT 12% IN ANTELOPE VALLEY WITH DISARM? THEY HAD A DIRECT IMPACT. 

PAUL HIGA: AGAIN, I BELIEVE THAT, WHEN YOU'RE TARGETING THE HIGHEST RISK PROBATIONS AND PAROLEES AND ESPECIALLY THOSE THAT HAVE BOTH A VIOLENT CRIMINAL HISTORY AND PRIOR POSSESSION OF WEAPONS AND THEY'RE ALSO IN VIOLATION OF THE CONDITIONS OF THE PAROLE OR PROBATION SHOULD TRIGGER SOME VERY-- GIVEN A LOT OF ATTENTION, WHICH SHOULD BE THE TARGET OF ANY PROBATION OR PAROLE SEARCHES. 

SUP. ANTONOVICH: HAVE THERE BEEN ANY REQUESTS TO HAVE A PAROLE OFFICER DEDICATED TO WORK WITH DISARM? 

PAUL HIGA: ALTHOUGH WE HAVE A PAROLE LIAISON WITH CLEAR, WE HAVE NOT HAD A SPECIFIC LIAISON WITH DISARM, ALTHOUGH WE WORK VERY CLOSELY WITH PAROLE AND OTHER AREAS AND WITH MAJOR TACTICAL OPERATIONS, GANG SWEEPS OR SWEEPS OF GEOGRAPHIC AREAS. SO OUR CONNECTIONS AND CONTACTS WITH PAROLE ARE VERY GOOD. 

SUP. ANTONOVICH: SO STATE PAROLE STAFF ARE RESPONSIVE WHEN CONTACTED BY OUR STAFF? 

PAUL HIGA: YES, THEY ARE. 

SUP. ANTONOVICH: WOULD YOU HAVE ANY CONCERNS OF HAVING A PAROLE OFFICER DEDICATED TO WORK WITH DISARM? 

PAUL HIGA: NO, I WOULDN'T AND, AGAIN, I THINK THAT I HAD A CALL INTO WALT ALLEN THIS MORNING JUST TO TALK BRIEFLY ABOUT MEETING AND COORDINATING SOME OF OUR EFFORTS AND THAT WAS AN ISSUE THAT I BROUGHT TO THE TABLE THAT WILL COME UP FOR DISCUSSION AT A LATER POINT. 

SUP. ANTONOVICH: REGISTERED SEX OFFENDERS, DO THEY HAVE MONTHLY PAROLE OR DO THEY HAVE ANY TYPE OF PAROLE OFFICER OR PROBATION OFFICER VISITING THEM OR ARE THEY AUTOMATICALLY REGISTERED WITH A RESPONSIBILITY TO CONTACT THE LOCAL POLICE DEPARTMENT WHEN THEY EVER MOVE? 

PAUL HIGA: THEY CERTAINLY, ONCE THEY ARE EVEN OFF PROBATION OR PAROLE HAVE THAT LIFETIME REQUIREMENT. WHEN THEY'RE ON PROBATION, WE CLOSELY MONITOR WHETHER OR NOT THEY'RE REGISTERED. I CAN'T SPEAK FOR PAROLE IN TERMS OF HOW THEY'RE MONITORING BUT I KNOW THAT THAT'S AN AREA WHERE WE ARE IN A VERY 90 PLUS PERCENT IN TERMS OF MAKING SURE THAT THOSE REGISTRANTS ARE, IN FACT, REGISTERED AND THAT WE ALSO HAVE SOME MONTHLY CONTACT WITH THEM. 

SUP. ANTONOVICH: SO THE AGENCY THAT WOULD BE RESPONSIBLE TO ENSURE THAT, SAY, DOING AN AUDIT ON THOSE THAT ARE REGISTERED THAT THEY ARE ACTUALLY THERE WOULD BE THE STATE? 

PAUL HIGA: CORRECT AND, IN LOOKING AT OUR STATS THIS MORNING, WE WERE WELL OVER 90 PLUS PERCENT IN THOSE THAT ARE VIOLATING PROBATION OR THE POTENTIAL VIOLATION FOR FAILURE TO APPEAR TO RETURN THEM TO COURT QUICKLY. 

SUP. ANTONOVICH: THE-- MR. ROSCOE, WHO WAS ARRESTED FOR SHOOTING DEPUTY SHERIFF GARY ORTIZ, HE WAS-- HE WAS BEING-- THE DEPUTY WAS PURSUING THE STATUS OF MR. OROSCOE. NOW, DO SHERIFF DEPUTIES DO THAT OR DO THEY DO THAT IN COOPERATION WITH THE STATE PROBATION OR WITH COUNTY PROBATION? HOW DOES THAT PROTOCOL WORK? 

PAUL HIGA: MR. OROSCOE WAS ON PAROLE, SO THAT'S INFORMATION THAT SHOULD HAVE BEEN COORDINATED THROUGH PAROLE, ALONG WITH LAW ENFORCEMENT AND PAROLE DOES HAVE THE SAME KIND OF MONTHLY REQUIREMENTS AT A MINIMUM TO BE SEEN BY THE PAROLE AGENTS AS WE DO HAVE FOR OUR DEPUTY PROBATION OFFICERS. 

SUP. ANTONOVICH: OKAY. SO THEN ABOUT A COUPLE WEEKS, WE'LL GET SOME PROTOCOL WITH PROPOSALS? 

PAUL HIGA: YES, YES. 

SUP. ANTONOVICH: THANK YOU. 

PAUL HIGA: YEP. 

SUP. KNABE: YOU'LL PREPARE THAT FOR ALL OF US, IS THAT CORRECT? 

SUP. ANTONOVICH: YEAH, FOR THE WHOLE BOARD. 

PAUL HIGA: YES. 

SUP. ANTONOVICH: THANK YOU, PAUL. 

SUP. MOLINA, CHAIR: AND I DON'T HAVE ANY SPECIALS. MS. BURKE? 

SUP. BURKE: I MOVE THAT, WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF NORMAN S. JOHNSON, FORMER DIRECTORS OF L.A. COUNTY DEPARTMENT OF PARKS AND RECREATION IN THE '50S AND '60S WHO PASSED AWAY AT 92, TWO DAYS BEFORE HIS 93RD BIRTHDAY ON JUNE 24TH. DURING HIS TENURE AS PARKS CHIEF, HE CAMPAIGNED FOR ADDITIONAL TAX FUNDS TO PROVIDE REGIONAL PARKS THROUGHOUT THE COUNTY. AFTER HIS RETIREMENT, HE SERVED MORE THAN 20 YEARS ON THE INVESTMENT BOARD OF THE L.A. COUNTY EMPLOYEES RETIREMENT FUND AND ON THE BOARD OF THE RETIRED EMPLOYEES OF L.A. COUNTY. HE WAS EDUCATED IN PUBLIC ADMINISTRATION AT U.S.C. AND SERVED IN ARMY AIR FORCE. HE IS SURVIVED BY HIS WIFE, DOROTHY AND HIS SON, STEVEN. I ALSO WANT TO JOIN IN THE ADJOURNMENT FOR STEVE BELL WHO, AFTER HIS RETIREMENT FROM K.T.L.A., BECAME DIRECTOR OF THE MUSEUM OF TELEVISION AND RADIO IN BEVERLY HILLS AND ALSO HE WAS A LECTURER ON HISTORY OF OPERA AND HE WAS VERY INVOLVED IN TERMS OF THE OPERA LEAGUE AND WAGNER SOCIETY OF SOUTHERN CALIFORNIA. AND LUTHER VANDROSS, WHO PASSED AWAY FRIDAY, JULY 1ST, AT THE AGE OF 54. HE WAS A GRAMMY-WINNING R AND B SINGER WHOSE CAREER WAS INTERRUPTED TWO YEARS AGO BY A STROKE. HE MADE A DRAMATIC RETURN TO THE PUBLIC SPOTLIGHT WITH HIS 2003 ALBUM, "DANCE WITH MY FATHER," WHICH EARNED HIM FOUR GRAMMY AWARDS, INCLUDING SONG OF THE YEAR AND FIRST NUMBER ONE ALBUM ON THE POP CHART OF HIS LONG CAREER. A MONTH LATER, HE WAS GIVEN FOUR N.A.A.C.P. IMAGE AWARDS. HE'S SURVIVED BY HIS MOTHER, MARY IDA VANDROSS. AND JAMES E. ABERNATHY, WHO PASSED AWAY ON JUNE 25TH, 2005. HE WAS A LONG-TIME ACTIVE MEMBER OF VICTORY BAPTIST CHURCH. HE BECAME PRESIDENT OF ASHLEY- GRISBY MORTUARY IN MAY '85 AND REMAINED IN THAT POSITION UNTIL HIS PASSING. HE WAS AN ACTIVE MEMBER AND PARTICIPANT OF THE LOCAL, STATE AND NATIONAL FUNERAL DIRECTORS AND EMBALMERS ASSOCIATION, A MEMBER OF EPSILON MU DELTA MORTUARY FRATERNITY AND A MEMBER OF ST. JOSEPH GRAND LODGE. HE LEAVES TO CHERISH HIS MEMORY HIS CHILDREN, JAMES AND VERONICA, HIS GRANDSON, HIS THREE SISTERS AND ONE BROTHER AND A HOST OF NIECES, NEPHEWS, COUSINS AND FRIENDS. AND REYNALDO "OBIE" BENSON, ONE OF THE ORIGINAL MEMBERS OF THE MOTOWN LEGENDARY FOUR TOPS, WHO PASSED AWAY ON FRIDAY, JULY 1ST, 2005, AT THE AGE OF 69. THAT CONCLUDES MY-- I HAVE NO SPECIALS. THAT CONCLUDES MY ITEMS. 

SUP. MOLINA, CHAIR: SO ORDERED ON THOSE ADJOURNMENTS. ALL RIGHT. WELL, WE HAVE ITEM S-1 AND ITEM 66, WHICH HAS ALSO BEEN HELD FOR A REPORT. I THINK WE CAN DO THEM TOGETHER BUT LET'S BEGIN WITH S-1, SO I'M GOING TO ASK DR. GARTHWAITE IF HE'D JOIN US AND I DON'T KNOW IF KAE IS HERE FOR NAVIGANT OR WHO IS COMING. 

DR. THOMAS GARTHWAITE: SUPERVISOR, KAE ROBERTSON'S PLANE WAS CANCELED OUT OF CHICAGO, SO SHE'S DELAYED. AND HANK WELLS, WE HAD A MEETING WITH THE OUTSIDE CONSULTANTS ON CONTRACTING OUT. SO I WILL ATTEMPT TO GIVE BOTH PERSPECTIVES, ALONG WITH MR. HENRY. OVER THE PAST WEEK, SEVERAL THINGS HAVE HAPPENED. THE RESIDENTS HAVE BEGUN THEIR FIRST PART OF THEIR YEAR, SO WE HAVE NEW RESIDENTS AND HAVE ORIENTED THEM AND COMMUNICATED TO THEM THE IMPORTANCE OF RESIDENCY SUPERVISION AND ALL THE THINGS THAT ARE GOING ON AT THE HOSPITAL. WE HAD GOOD NEWS. WE WERE ABLE TO HIRE A PHARMACY DIRECTOR AND WE'VE MADE AN OFFER FOR ONE OF THE CLINICAL DIRECTORS OF NURSING WHICH WE'RE HOPEFUL THAT THAT WILL BE ACCEPTED. WE'RE CONTINUING M.T.A.L.A. TRAINING, AS IDENTIFIED IN THE REPORT, AS WELL AS BOTH REEMPHASIZING AND RETRAINING IN REGARDS TO TRIAGE IN THE EMERGENCY ROOM AND LIMITING THE NUMBER OF STAFF, MAKING THEM MORE DEDICATED FOR THE TRIAGE PROCESS ITSELF. DREW UNIVERSITY HAS HAD A SIGNIFICANT WEEK. THEY HAVE APPOINTED A NEW PRESIDENT-- I'M SORRY, PROVOST AND ACTING PRESIDENT, TOM YOSHIKAWA, WHO HAD BEEN THE CHAIR OF MEDICINE. WE MET WITH HIM LAST THURSDAY TO REITERATE THE CHALLENGES AHEAD AND THE IMPORTANCE OF RAPID AND DECISIVE ACTION ON THE PART OF THE UNIVERSITY IN PREPARATION FOR DECEMBER'S A.C.G.M.E. VISIT. WE WERE VERY ENCOURAGED BY THAT MEETING. I THINK DR. CHERNOF AND I MET WITH HIM. IN ADDITION, THEY'VE APPOINTED A NEW DESIGNATED INSTITUTION OFFICIAL. THIS IS THE INDIVIDUAL WHO COORDINATES THE GRADUATE MEDICAL EDUCATION COMMITTEE FOR THE UNIVERSITY AND WHO WILL BE KEY IN THE UPCOMING VISIT IN DECEMBER. THIS DOCTOR IS DR. NANCY HANNAH. SHE WAS A KEY FIGURE AND-- IN THE DEPARTMENT OF MEDICINE AND TURNING THAT PROBATION INTO ACCREDITATION WITH COMMENDATION FROM A.C.G.M.E. THERE, I BELIEVE, WILL BE AN ACTING DEAN AND A NEW DEAN APPOINTED IN THE NOT TOO DISTANT FUTURE AS DR. ISHIKAWA TAKES ON HIS ROLES. AND, FINALLY, WE'VE SIGNED AN AGREEMENT WITH SHATTUCK HAMMOND PARTNERS TO EXPLORE THE CONTRACTING OUT AS DIRECTED BY THIS BOARD AND THEY ARE IN TOWN. IN FACT, I'D BEEN MEETING WITH THEM BEFORE I GOT HERE AND FULLY ENGAGED IN THE PROCESS FOR PRODUCING A REPORT FOR EARLY AUGUST. SO, WITH THAT, I WILL STOP AND SEE IF MR. HENRY WOULD LIKE TO BRING YOU UP TO DATE ON THE HUMAN RESOURCES ASPECT OF OUR WORK AT KING DREW. 

MICHAEL J. HENRY: MADAM CHAIR, MEMBERS OF THE BOARD, OUR OPEN CASE LOG DID NOT GO DOWN SIGNIFICANTLY FOR THE PAST WEEK. ALTHOUGH WE CLOSED OUT 12 ADDITIONAL CASES, WE RECEIVED 10 ADDITIONAL CASES, FOR A NET GAIN FROM THE LAST TUESDAY TO THIS TUESDAY OF ABOUT TWO POSITION'S REDUCTION. THOSE PARTICULAR CASES WERE OF A BROAD SPECTRUM. SOME NURSES, OTHER EMPLOYEES WITH A VARIETY OF DIFFERENT-- DIFFERENT ISSUES, BRAND-NEW CASES. THE GOOD NEWS, AS DR. GARTHWAITE MENTIONED, IS THAT WE HAVE HIRED A PHARMACIST, CHIEF OF PHARMACY, AND WE ARE MAKING A OFFER TO ONE OF THE MANAGING NURSES. SO THOSE PERMANENT EMPLOYEES, HOPEFULLY, WILL BE ON VERY SHORTLY. 

SUP. ANTONOVICH: WHAT'S THE TIME FRAME FOR THAT? 

MICHAEL J. HENRY: WELL, WE'VE MADE THE OFFER, SO WE'RE JUST WAITING. IT'S A MATTER-- COULD HEAR THIS AFTERNOON OR TOMORROW ON THE NURSE. THE PHARMACIST IS HIRED, HE DID ACCEPT, SO WE HAVE THAT. 

SUP. ANTONOVICH: START WITHIN A WEEK OR WITHIN THE MONTH? 

MICHAEL J. HENRY: I DON'T KNOW. I DON'T KNOW. IT'S PROBABLY-- HE'LL START WITHIN, JUST A GUESS WOULD BE 15 TO 30 DAYS BUT I CAN GET THAT EXACT INFORMATION FOR YOU. THE C.E.O. POSITION, WE HAVE TWO ADDITIONAL CANDIDATES THAT WE'RE GOING TO INTERVIEW ON THURSDAY. AFTER THOSE INTERVIEWS ARE COMPLETED, I PLAN TO WORK WITH THE COMMITTEE TO SEND THE MOST QUALIFIED CANDIDATES FORWARD TO DR. GARTHWAITE FOR THAT PROCESS TO TAKE PLACE AS WELL. 

SUP. MOLINA, CHAIR: SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: ON YOUR JUNE 30TH REPORT, DR. GARTHWAITE, SUMMARY REPORT ON THE PHYSICIAN AND MANAGEMENT PERFORMANCE EVALUATIONS, WHY AREN'T WE ABLE TO PROVIDE ACTUAL PATIENT VISITS TO RADIOLOGY AND OUTPATIENT CLINICS? YOU ONLY HAVE THE AGGREGATE. 

DR. THOMAS GARTHWAITE: I'M SORRY. YOU'RE ASKING WHY WE DON'T HAVE... 

SUP. ANTONOVICH: THE ACTUAL PATIENT VISITS. 

DR. THOMAS GARTHWAITE: WELL, WE CAN GET THAT INFORMATION CURRENTLY BUT, BECAUSE IT'S NOT LOGGED INTO OUR COMPUTER SYSTEM AND IT'S NOT VERIFIED IN A WAY THAT WE'RE COMFORTABLE WITH, IT'S JUST MUCH MORE LABORIOUS TO GO THROUGH, YOU KNOW, VERIFYING AND BRINGING ALL THAT INFORMATION UP. SO WHAT THIS IS HAS TO DO WITH GETTING IT ELECTRONICALLY IN A VERIFIED FASHION SO THAT WE HAVE ONLY ONE SYSTEM THAT'S ELECTRONIC, NOT A MANUAL SYSTEM AND AN EMERGING ELECTRONIC SYSTEM THAT'S NOT A HUNDRED PERCENT ACCURATE. 

SUP. ANTONOVICH: WHAT DO YOU MEAN BY STATING THE DEPARTMENT OF HUMAN RESOURCES WILL BE DOING TARGET TRAINING FOR PHYSICIANS, ON PAGE 2 WHERE YOU'RE TALKING ABOUT PHYSICIAN MANAGEMENT MONITORING AND PERFORMANCE EVALUATIONS, YOUR LAST SENTENCE? 

DR. THOMAS GARTHWAITE: I THINK THAT ANYONE WHO HAS DONE PERFORMANCE EVALUATIONS TO ANY DEGREE WILL UNDERSTAND THAT IT'S IMPORTANT TO FILL OUT THOSE PERFORMANCE EVALUATIONS IN AN OPEN AND ACCURATE WAY AND WITH FULL COMMUNICATION WITH THE EMPLOYEE. I THINK THAT, AT LEAST IN MY EXPERIENCE, TOO OFTEN, PERFORMANCE EVALUATIONS DONE POORLY OR NOT DONE TIMELY LEAD TO SIGNIFICANT PERSONNEL ACTIONS LATER. SO THERE'S IMPORTANT KEYS IN HOW YOU STATE WHAT'S IN THERE, HOW YOU DOCUMENT HOW IT WAS COMMUNICATED TO THE EMPLOYEE AND SO FORTH. AND, TYPICALLY, YOU KNOW, THEY'RE NOT DONE AS WELL AS THEY COULD BE. AND PHYSICIANS, I THINK, IN GENERAL HAVE NOT BEEN TRAINED IN HOW TO DO THOSE WELL AND SO WE'RE TRYING TO WORK WITH MR. HENRY AND HIS GROUP TO MAKE SURE THAT THEY'RE ALL TRAINED IN HOW TO DO THIS WELL. 

MICHAEL J. HENRY: DO THEM CORRECTLY. 

SUP. ANTONOVICH: YOUR AFFILIATION AGREEMENT MONITORING AND OVERSIGHT, YOU INDICATE THAT DREW UNIVERSITY COMPONENT HAS BEEN FULLY IMPLEMENTED FOR FOUR MONTHS, THAT THE UNIVERSITY HAS RECEIVED SANCTIONS OF $21,000 FOR THE FOURTH QUARTER OF '04 AND $1,000 FOR THE FIRST QUARTER OF '05 FOR FAILING TO COMPLETE REQUIRED REPORTING REQUIREMENTS AND THAT THE UNIVERSITY ALSO HAS A 300,000-DOLLAR WITHHOLD FOR NOT LOGGING THE FULL NUMBER OF CLINICAL HOURS PER MONTHS AVAILABLE UNDER OUR CONTRACT. SO WHAT IS THE UNIVERSITY-- DREW UNIVERSITY DOING TO MEET THE REPORTING REQUIREMENTS OF THEIR AFFILIATION AGREEMENT? 

DR. THOMAS GARTHWAITE: WELL, CLEARLY, THE CONCERNS WE HAVE OUT OF THESE MONITORING ASPECTS WERE PART OF OUR COMMUNICATION WITH DR. ISHIKAWA AS HE ASSUMES HIS ROLES AS ACTING PRESIDENT AND PROVOST AND WILL BE PART OF THE DISCUSSIONS WE HAVE WITH DR. HANNAH AND HER NEW ROLE AS D.I.O. IT IS CLEARLY THE RESPONSIBILITY OF THE DESIGNATED INSTITUTIONAL OFFICIAL AND THE DEAN TO BRING US-- TO GET US THOSE REPORTS IN A TIMELY MANNER AND TO SET UP MECHANISMS TO DOCUMENT THE HOURS OF TEACHING THAT ARE PRODUCED SO THAT WE CAN PAY FOR JUST THE HOURS THAT ARE ACTUALLY ACCOMPLISHED. WE'RE BOTH, I THINK, OPTIMISTIC THAT WE HAD A GOOD MEETING AND THAT THEY FULLY UNDERSTAND THE IMPORTANCE OF THIS. I THINK IT REFLECTS WELL ON THE SYSTEM FOR MONITORING THAT WE SET UP AND THE CONTRACT WITH THE PROVISIONS FOR SANCTIONING AND FOR ASSURING THAT THE CONTRACT IS CARRIED OUT APPROPRIATELY. 

SUP. ANTONOVICH: DR. ISHIKAWA WAS INVOLVED WITH THE TIME CARD FRAUD CASES. HAVE YOU REVIEWED THE ISSUES WITH HIM AND STATED THAT HE WAS NOT INVOLVED AND THEREFORE SHOULD BE PROMOTED? 

DR. THOMAS GARTHWAITE: WELL, IT WASN'T OUR DECISION TO-- YOU KNOW, THAT'S A DECISION FOR DREW UNIVERSITY BUT I BELIEVE THAT THE DETAIL RELATED TO THIS WOULD SUGGEST THAT DR. ISHIKAWA WAS CARRYING OUT HIS DUTIES IN A PROPER FASHION. 

SUP. ANTONOVICH: DID YOU REVIEW THAT TO HAVE A COMFORT LEVEL THAT HE WAS AND THEREFORE WAS NOT TO BE HELD ACCOUNTABLE FOR THE TIMECARD FRAUD THAT OCCURRED UNDER HIS ADMINISTRATION? 

DR. THOMAS GARTHWAITE: I LOOKED AT THIS WHEN IT FIRST CAME UP AND DID NOT FEEL THAT DR. ISHIKAWA HAD DONE ANYTHING BUT POINT OUT CONCERNS HE HAD WITH TIMECARD ISSUES, AND THERE CERTAINLY HAS BEEN AN ISSUE BACK AND FORTH AS TO WHOSE RESPONSIBILITY IT WAS TO FOLLOW THROUGH BUT AT LEAST SOME OF THE ISSUES THAT WERE RELATED TO DR. ISHIKAWA AND TIMECARD PROBLEMS IN HIS DEPARTMENT WERE RAISED BY HIM. THERE ARE SOME QUESTIONS AS TO HOW THAT WAS FOLLOWED THROUGH UPON. I HAVEN'T REVIEWED THAT RECENTLY. 

SUP. ANTONOVICH: IN YOUR FEBRUARY 7TH REPORT THIS YEAR ON THE TIME ABUSE, THE POINT MADE, THE PARAGRAPH SAID, "WORK WITH HUMAN RESOURCES TO TAKE APPROPRIATE ACTION AGAINST DR. ISHIKAWA AND DR. JOAQUIN CONSISTENT WITH THE EMPLOYEE EVALUATION DISCIPLINE GUIDELINES, SECTION 5060 E-JOB PERFORMANCE NUMBER 9 FOR FAILURE TO CARRY OUT SUPERVISORIAL DUTIES AND RESPONSIBILITIES ADEQUATELY AND PROMPTLY BY NOT VERIFYING PHYSICIAN'S TIMECARDS, COMPLETING PERFORMANCE EVALUATIONS, PROVIDING OUTSIDE EMPLOYMENT FORMS, VIOLATING THE D.H.S. NEPOTISM POLICY AND FOR NOT TAKING CORRECTIVE ACTION FOR PERCEIVED INAPPROPRIATE BEHAVIOR." NOW, THIS IS YOUR REPORT TO US ON FEBRUARY 7TH. WHAT HAPPENED IN THE MEANTIME? 

DR. THOMAS GARTHWAITE: I WOULD NEED TO REVIEW THAT AND TO REVIEW THE ADVISABILITY OF DISCUSSING THAT IN A PUBLIC FORUM BEFORE I THINK WE COULD GO FURTHER. 

SUP. ANTONOVICH: SO IN PRIVATE-- IN EXECUTIVE SESSION, YOU CAN DISCUSS-- THAT'S FINE. SO YOU FEEL THAT IT'S APPROPRIATE-- AND THEN WE'LL DISCUSS IT, YOU FEEL IT'S APPROPRIATE THAT HE BE APPOINTED AS A PROVOST BY THE UNIVERSITY? 

DR. THOMAS GARTHWAITE: YEAH. I HAVE A GREAT DEAL OF RESPECT FOR TOM YOSHIKAWA. I THINK, WE'VE WORKED WITH HIM CLOSELY OVER THE LAST YEAR PLUS, SINCE WE'VE HAD TROUBLES AT KING DREW MEDICAL CENTER. TOM IS SOMEONE WHO IS THERE SEVEN DAYS A WEEK. YOU CAN FIND HIM IN HIS OFFICE, YOU CAN FIND HIM ON THE WARDS. I SEE HIM THERE, SEEING PATIENTS, WRITING NOTES IN THE CHARTS. I THINK THAT, YOU KNOW, THIS IS A VERY DEDICATED, ETHICAL, HARD WORKING INDIVIDUAL WHO WILL APPLY HIMSELF IN A SIMILAR MANNER TO HIS NEW JOB AS HE HAS IN HIS PAST AND I THINK, IF YOU LOOKED AT THE DEPARTMENTS AT KING DREW, MEDICINE IS ONE OF THE STRONGER ONES. 

SUP. ANTONOVICH: I WAS JUST READING WHAT YOU WERE QUOTING ABOUT HIM, THOUGH, WHICH IS DIFFERENT THAN WHAT YOU'RE TELLING US RIGHT NOW. THAT WAS THE QUESTION. WHEN WILL WE... 

SUP. KNABE: THAT WAS YOUR REPORT. 

DR. THOMAS GARTHWAITE: YEAH, BUT I THINK, YOU KNOW, THE QUESTIONS AS TO WHETHER AN INDIVIDUAL HAS FOLLOWED EVERY-- THE LETTER OF EVERY POSSIBLE RULE OR AROUND CONTRACTING IN THE COUNTY OR NOT IS-- IT'S AN OBJECTIVE REPORT AS TO WHETHER EVERY RULE IS FOLLOWED. IT DOESN'T GIVE YOU THE WHOLE SENSE OF THE INDIVIDUAL OR WHAT THEY'RE CONTRIBUTING TO THE GOOD OF THE ORGANIZATION. 

SUP. KNABE: BUT YOU COULD HAVE ADDED THAT TO THE REPORT. 

DR. THOMAS GARTHWAITE: YEAH, THAT'S TRUE. BE HAPPY TO-- BE HAPPY TO ADD IN THINGS LIKE THAT IN THE FUTURE, IF YOU LIKE. 

SUP. ANTONOVICH: WHEN WILL WE RECEIVE THE DEPARTMENT'S AUDIT REPORT ON CONTRACTED PHYSICIANS? 

SUP. KNABE: I HAD SOME QUESTIONS. I MET WITH THE AUDIT AND COMPLIANCE STAFF ON FRIDAY. THEY PROVIDED ME AN AMENDED COPY TODAY AND I'LL BE READING THAT PROBABLY TONIGHT OR TOMORROW AND, PENDING MY COVER LETTER, AND SHOULD BE DONE. 

SUP. ANTONOVICH: HAS THE IMPLEMENTATION OF THE ZERO TOLERANCE POLICY STOPPED THE BAD BEHAVIOR BY PHYSICIANS IN THE PERIOPERATIVE ROOMS, THE OPERATING? 

DR. THOMAS GARTHWAITE: TO MY KNOWLEDGE. I DON'T HAVE ANY SPECIFIC KNOWLEDGE ON THAT. 

SUP. ANTONOVICH: WHAT ACTIONS HAVE BEEN TAKEN AGAINST PHYSICIANS WHO HAVE EXHIBITED DISRUPTIVE BEHAVIOR IN THE OPERATING ROOM? 

DR. THOMAS GARTHWAITE: WELL, DEPENDS ON THE TYPE OF BEHAVIOR. ANYTHING FROM VERBAL COUNSELING AND BEYOND. WE'VE SUSPENDED PEOPLE, I THINK. 

SUP. ANTONOVICH: ON JUNE 24TH, YOU KNOW, YOU STATE THAT THE "GOVERNANCE COMMITTEE INSTITUTED A ZERO TOLERANCE FOR PHYSICIANS WITH DISRUPTIVE BEHAVIOR. THIS WILL..." I THINK THERE'S A TYPO HERE, "...THIS WILL A NEW PERFORMANCE MEASURE TRACT IN THE PERIOPERATIVE COMPASS. THIS IS IMPORTANT BECAUSE STAFF FEEL IT HAS PLAYED A ROLE IN BEHAVIOR THAT MIGHT CONTRIBUTE TO ERRORS AND DECREASES EFFICIENCY AND EFFECTIVENESS. IT IS ALSO A RETENTION ISSUE FOR NURSING STAFF." 

DR. THOMAS GARTHWAITE: RIGHT. WELL, YOU KNOW, LOOK, IT'S VERY IMPORTANT THAT ALL THE TEAM-- AN OPERATING ROOM IS REALLY A TEAM FUNCTION AND THE TEAM MEMBERS MUST WORK TOGETHER, THEY MUST RESPECT EACH OTHER, THEY MUST LISTEN TO EACH OTHER AND SO, YOU KNOW, DISRUPTIVE OR INTIMIDATING BEHAVIOR IS NOT ACCEPTABLE IN A OPERATING ROOM, SO THAT'S WHAT WE'RE... 

SUP. ANTONOVICH: SO WHAT ACTIONS HAVE BEEN TAKEN AGAINST THOSE PHYSICIANS WHO DID EXHIBIT THOSE TRAITS? 

DR. THOMAS GARTHWAITE: I DON'T KNOW SPECIFICALLY BUT I CAN FIND OUT. 

SUP. ANTONOVICH: WELL, I MEAN, YOU GIVE US A REPORT ON JUNE 24TH THAT ACTIONS, YOU KNOW, WILL BE TAKEN AGAINST THOSE. SO WE'RE ASKING, YOU KNOW, WHAT ACTIONS WERE TAKEN, SO I BELIEVE THAT'S A LEGITIMATE REQUEST. 

DR. THOMAS GARTHWAITE: I WOULD AGREE AND I WILL FIND OUT. 

SUP. ANTONOVICH: IN TODAY'S REPORT, YOU REPORTED THAT THE COUNTY SIGNED A AGREEMENT WITH CHADDOCK HAMM AND PARTNERS TO EXPLORE CONTRACTING WITH THE PRIVATE SECTOR HEALTH CENTERS TO ASSUME THE OPERATIONS AT KING DREW. WHAT KIND OF BACKGROUND OR EXPERIENCE IN SUCCESS DOES SHATTUCK HAMMOND PARTNERS HAVE IN THIS TYPE OF PROCEDURE? 

DR. THOMAS GARTHWAITE: WELL, THERE'S NOTHING EXACTLY LIKE THE SITUATION THE COUNTY FINDS ITSELF IN WITH KING DREW MEDICAL CENTER. SHATTUCK HAMMOND IS A LARGE NATIONAL SCOPE FIRM THAT HAS DEALT WITH MANY INSTITUTIONS IN THE LOS ANGELES AREA AS WELL AS AROUND THE COUNTRY AND THEY'RE HIGHLY RESPECTED ACROSS THE PRIVATE SECTOR. THE CHALLENGE WE HAVE IN EXPLORING THIS ACTION THAT THE BOARD ASKED US TO TAKE IS TO FIND SOME-- A FIRM THAT IS BELIEVABLE TO THE PRIVATE SECTOR PARTNERS WHO MIGHT CONSIDER CONTRACTING TO OPERATE KING DREW MEDICAL CENTER. AND SO THAT WAS THE TASK WE HAD WHEN TRYING TO SIFT THROUGH DIFFERENT CONSULTANTS. SO I CALLED SEVERAL C.E.O.S IN THE LOCAL COMMUNITY, ASKED WHO THEY WOULD HAVE THE MOST TRUST IN AND BELIEF IN TO HELP THEM WORK THROUGH THAT PROCESS. THIS CAME UP SEVERAL TIMES AND WE WERE ABLE TO BRING THEM ON. 

SUP. ANTONOVICH: ARE THEY THE ONLY AGENCY THAT DOES THAT TYPE OF SERVICE? 

DR. THOMAS GARTHWAITE: NO. THERE WOULD BE MANY. 

SUP. ANTONOVICH: WHAT WILL IT COST TO RENDER SERVICES FROM THEM AND WHEN WOULD YOU BE COMING TO THE BOARD WITH THE COST REQUESTS? 

DR. THOMAS GARTHWAITE: WELL, WE DO THIS THROUGH THE C.A.O.'S DELEGATED AUTHORITY AND, YEAH, I THINK IT'S 175,000 TOTAL. 

SUP. ANTONOVICH: COULD YOU TELL THE BOARD SOME OF THE PAST EXPERIENCE THAT THEY HAVE HAD AND SUCCESSES? 

DR. THOMAS GARTHWAITE: I DON'T KNOW SPECIFICALLY BUT I DID TALK TO THE C.E.O. AT CEDARS AS WELL AS THE HEAD OF THEIR PLANNING DEPARTMENT. I TALKED TO INDIVIDUALS VERY HIGH UP IN BOTH CATHOLIC HEALTHCARE WEST, DAUGHTERS OF CHARITY, CITRUS VALLEY HOSPITAL AND OTHERS, ALL OF WHOM HAD PERSONAL EXPERIENCE OF USING THEM IN NOT NECESSARILY EXACTLY THE SAME BUT SIMILAR TYPES OF HEALTHCARE CONSULTING SITUATIONS AND FOUND THEM TO BE HELPFUL. 

SUP. ANTONOVICH: MR. HENRY, HAVE YOU HAD ANY SUCCESS IN CONTACTING RETIRED PHARMACISTS FROM THE COUNTY RELATIVE TO THE 120 DAY...? 

MICHAEL J. HENRY: WE HAVE MADE THAT CONTACT THROUGH LACERA. WE'RE GOING TO USE LACERA AS OUR MECHANISM TO MAKE THE CONTACT. WE HAVE NOT RECEIVED YET ANY TAKERS BUT WE HAVE IMPLEMENTED IT. 

SUP. ANTONOVICH: AND WHAT'S ROUGHLY THE BALLPARK FIGURE, THE TOTAL NUMBER OF EMPLOYEES AT KING DREW MEDICAL CENTER THAT HAVE BEEN SUBMITTED FOR EVALUATION AND DISCIPLINE AND HOW MANY CASES HAVE BEEN DISCIPLINED? 

MICHAEL J. HENRY: THE GRAND TOTAL OF CASES IS 587, OF WHICH 450 HAVE CLOSED AND WE'VE GOT OPEN ABOUT 123 AND WE'VE GOT 13 REFERRED CASES. 

SUP. ANTONOVICH: AND, OF THE 450 THAT WERE CLOSED, HOW MANY WERE FIRED AND HOW MANY WERE DISCIPLINED? 

MICHAEL J. HENRY: LET'S SEE, DISCHARGES. IT'S, LIKE, ABOUT 96, IF I'M ADDING CORRECTLY HERE. NO, ACTUALLY, IT'S ABOUT 120, 122. 

SUP. ANTONOVICH: 122 WERE DISMISSED? 

MICHAEL J. HENRY: YES, THOSE WERE ACTUAL DISCHARGES. RELEASES, DISCHARGES AND DISCHARGES OF PROBATIONERS. I'M ADDING THESE UP IN MY HEAD. 

SUP. ANTONOVICH: SO ABOUT 122 WERE DISMISSED AND THE REST WERE PUT ON SUSPENSION? 

MICHAEL J. HENRY: THEY WERE REPRIMANDS, SUSPENSIONS... 

SUP. ANTONOVICH: REPRIMANDED-- AND REPRIMANDS VARIED FROM WHAT TO WHAT? 

MICHAEL J. HENRY: WELL, REPRIMANDS COULD BE ANYTHING ANYTHING FROM A ORAL REPRIMAND TO WRITTEN REPRIMAND. YOU CAN ALSO HAVE SUSPENSIONS OF LESS THAN FIVE DAYS ALL THE WAY UP TO 30 DAYS. 

SUP. ANTONOVICH: OKAY. MAYBE YOU COULD GIVE US A REPORT ON THAT, THOSE NUMBERS. THANK YOU. 

MICHAEL J. HENRY: SURE. 

SUP. MOLINA, CHAIR: ANY OTHER QUESTIONS? I HAVE SOME QUESTIONS. ON THE REPORT THAT YOU GAVE US THIS TIME, YOU HAVE A LOT OF INFORMATION ON DREW UNIVERSITY AS WELL AS THE RESIDENTS STARTING OUT. WHAT IS THE KIND OF COMMITMENT? THESE ARE, WHAT, TWO-YEAR RESIDENTS? HOW LONG IS THE RESIDENCY FOR THESE NEWLY ARRIVED-- THE 2005 RESIDENCY TRAINING? 

DR. THOMAS GARTHWAITE: IT WOULD-- CERTAINLY VARIES BY SPECIALTY. SO ANYWHERES FROM TWO TO FIVE YEARS, DEPENDING ON THE SPECIALTY. 

SUP. MOLINA, CHAIR: SO IF, IN FACT, THEY LOSE-- AND, AGAIN, I DON'T WANT TO SAY THE ACCREDITATION, BECAUSE WE GET-- IT GETS ALL-- IF WE DO NOT HAVE AN AFFILIATION AGREEMENT, WHAT WOULD HAPPEN TO THE RESIDENTS? 

DR. THOMAS GARTHWAITE: WELL, IT WOULD BE SIMILAR TO WHAT WE DID WITH RADIOLOGY AND SURGERY. WE WOULD END UP PLACING THEM. SOME RESIDENCIES, IT'S RELATIVELY EASY TO PLACE BECAUSE... 

SUP. MOLINA, CHAIR: IS IT OUR RESPONSIBILITY OR IS IT THE RESPONSIBILITY OF DREW FOR PLACEMENT? 

DR. THOMAS GARTHWAITE: I THINK, OVERALL, IT'S OUR RESPONSIBILITY BUT WE WOULD WORK WITH DREW, OBVIOUSLY. 

SUP. MOLINA, CHAIR: WHEN DOES THE PROCESS BEGIN IN ACCEPTING NEW RESIDENTS' APPLICATIONS AND SO ON? 

DR. THOMAS GARTHWAITE: WE HAVE TO HAVE EVERY DECISION MADE BY NOVEMBER. 

SUP. MOLINA, CHAIR: SO, THIS NOVEMBER, THEY'LL BE SELECTING THEIR RESIDENTS FOR, WHAT? THE COMING YEAR? 

DR. THOMAS GARTHWAITE: WE HAVE TO COMMIT AND RESIDENTS BEGIN TO COMMIT IN NOVEMBER. THE ACTUAL MATCH COMES OUT IN MARCH. 

SUP. MOLINA, CHAIR: SO ARE YOU PROCEEDING ON THAT PROCESS? 

DR. THOMAS GARTHWAITE: WE'RE PROCEEDING ON THE PREMISE THAT WE HAVE TO HAVE A DECISION ON NEXT YEAR'S RESIDENCY AND-- OR NOT BY NOVEMBER OF THIS YEAR. SO... 

SUP. MOLINA, CHAIR: LET ME UNDERSTAND THIS CORRECTLY. WHETHER YOU'RE GOING TO HAVE A RESIDENCY OR NOT, YOU'RE GOING TO DECIDE THAT IN NOVEMBER? 

DR. THOMAS GARTHWAITE: WE HAVE TO DETERMINE, FOR THE FUTURE BY NOVEMBER. SO WE HAVE TO MAKE SURE THAT ANY CHANGES, EVERY CHANGE IN RESIDENCY PROGRAM, ANY CONTEMPLATED CHANGE IN RESIDENCY ARE DECIDED BY THIS NOVEMBER. 

SUP. MOLINA, CHAIR: SO, RIGHT NOW-- SO WHEN WOULD THE APPLICATION PROCESS BE GOING ON? IT'S GOING ON NOW FOR THE SELECTION IN NOVEMBER? 

DR. THOMAS GARTHWAITE: BE GOING ON THROUGH THE FALL. FINAL SELECTIONS ARE PUT FORWARD TO THE MATCH IN DECEMBER, I BELIEVE, LIKE, EARLY DECEMBER. 

SUP. MOLINA, CHAIR: LET ME TRY ASKING IT AGAIN. SO THE QUESTION IS, THEN, ARE YOU ACCEPTING APPLICATIONS FOR FUTURE RESIDENCIES AT M.L.K.? 

DR. THOMAS GARTHWAITE: TODAY? YES. BUT THE DECISION TO MOVE FORWARD-- WE WILL NEED TO BE, I THINK, LEADING UP TO THE FINAL DECISION NOVEMBER/DECEMBER, WE WILL NEED TO AT LEAST ENTERTAIN THAT WE WOULD BE HAVING A DREW RESIDENCY PROGRAM UP UNTIL WE MAKE THAT FINAL DECISION, THE BOARD CAN MAKE THAT IN AUGUST, IT COULD MAKE IT IN NOVEMBER OR DECEMBER BUT WE SHOULD MAKE IT BY NOVEMBER. 

SUP. YAROSLAVSKY: YOU'RE NOT APPROVING ANYBODY, YOU'RE NOT GRANTING... 

DR. THOMAS GARTHWAITE: NO, WE WOULD NOT-- THERE WOULD NOT BE ANY CHANGE. WOULDN'T BE ANY ACCEPTED RESIDENTS... 

SUP. MOLINA, CHAIR: BUT YOU ARE GOING THROUGH THE PROCESS OF ACCEPTING APPLICATIONS FOR RESIDENCIES FOR THE FOLLOWING YEAR? 

DR. THOMAS GARTHWAITE: RIGHT. WE WOULD GO THROUGH IT FOR THIS FALL UNTIL THE DECISION IS MADE. OTHERWISE, WE WOULDN'T-- THERE WOULD BE NO HOPE IF WE WOULD DECIDE RESIDENTS, TO BE ABLE TO GET THEM. WE'VE BEEN HONEST WITH THE RESIDENTS ABOUT WHAT'S GOING ON IN THE PAST. WE'VE CLEARLY TOLD THEM, YOU KNOW, WHAT THE DISCUSSIONS ARE AND TRIED TO ACTUALLY JUST HAVE AN OPEN DISCUSSION ABOUT THE-- YOU KNOW, THE NATURE OF WHAT'S BEEN GOING ON AT THE UNIVERSITY AND THE MEDICAL CENTER. 

SUP. MOLINA, CHAIR: AND DID YOU HAVE PROBLEMS IN THE PLACEMENTS BEFORE? DID YOU GET EVERYBODY PLACED? 

DR. THOMAS GARTHWAITE: YEAH, I THINK WE DID QUITE WELL, I THINK, IN SURGERY AND WE HAD SOME TROUBLE IN RADIOLOGY BECAUSE THERE ARE RELATIVELY FEW PROGRAMS BUT I THINK WE PLACED EVERYONE BUT ONE? 

SUP. BURKE: I THOUGHT SIX PEOPLE... 

DR. THOMAS GARTHWAITE: YEAH. EVERYONE. YEAH. SO WE WERE ABLE TO WORK THROUGH IT. I MEAN... 

SUP. MOLINA, CHAIR: AND, IN THE-- AS FAR AS DREW UNIVERSITY THAT IT'S TRYING TO WORK THROUGH MANY OF THESE ISSUES, NOW THAT DR. ISHIKAWA HAS BECOME THE PROVOST, DOES THAT CHANGE HIS ROLE OR RESPONSIBILITY OVER AT M.L.K.? 

DR. THOMAS GARTHWAITE: YEAH, IT WILL AT THE HOSPITAL AND... 

SUP. MOLINA, CHAIR: SO HE KNOWS YOU HAVE NO LONGER A CHAIR OF INTERNAL MEDICINE? IS IT INTERNAL MEDICINE? 

DR. THOMAS GARTHWAITE: INTERNAL MEDICINE, RIGHT. 

SUP. MOLINA, CHAIR: SO YOU NO LONGER HAVE A CHAIR? 

DR. THOMAS GARTHWAITE: WELL, THERE'S AN ACTING CHAIR. 

SUP. MOLINA, CHAIR: WHO'S YOUR CHAIR? 

DR. THOMAS GARTHWAITE: THE CARDIOLOGIST. I'M BLANKING ON THE NAME RIGHT NOW. I'LL THINK OF IT. 

SUP. MOLINA, CHAIR: SO, AS THE PROVOST, HE NO LONGER IS DOING MEDICAL SUPERVISION AT THE HOSPITAL ITSELF? 

DR. THOMAS GARTHWAITE: YEAH, I DON'T IMAGINE THAT HE'LL RETAIN ANY CLINICAL PRESENCE BUT THAT SOME CHAIRS AND SOME-- SOME ADMINISTRATORS DO KEEP A CLINICAL ROLE. SOME DON'T. AND I DON'T KNOW THAT. I DON'T KNOW THAT FROM HIM. 

SUP. MOLINA, CHAIR: ALL RIGHT. IN-- WITH CHADDOCK HAMMOND PARTNERS, I'M READING OFF OF YOUR OWN REPORT, WHAT KIND OF PARAMETERS DID THEY HAVE? IN OTHER WORDS, WHAT ARE THEY OUT THERE LOOKING FOR? 

DR. THOMAS GARTHWAITE: WELL, THEY'VE BEEN HIRED TO ENGAGE THE TWO HEALTH SYSTEMS THAT HAVE SHOWN SOME INTEREST IN THE QUESTION AT HAND WHICH IS WOULD YOU CONSIDER CONTRACTING TO TAKE OVER THE OPERATIONS AT KING DREW MEDICAL CENTER? AND THEY'RE CURRENTLY... 

SUP. MOLINA, CHAIR: WHAT DOES THAT MEAN? PHYSICALLY COME IN AND THEY WOULD NOW MANAGE THE HOSPITAL IN ITS PHYSICAL LOCATION? 

DR. THOMAS GARTHWAITE: YEAH, I THINK THAT'S-- THAT'S CORRECT. IT WAS A BOARD MOTION THAT WE'RE TRYING TO RESPOND TO. 

SUP. MOLINA, CHAIR: I UNDERSTAND. THAT'S WHY, AT THAT TIME, I WASN'T SURE EXACTLY WHAT AND HOW THAT WAS GOING TO PROCEED. NOW YOU'VE HIRED SOMEBODY AND YOU'RE PAYING SOMEBODY TO DO IT. I'M WONDERING, WHAT IS IT EXACTLY THAT THEY'RE DOING? WHEN YOU SAY ENGAGE, WHAT DOES THAT MEAN? 

DR. THOMAS GARTHWAITE: WELL, TO ME WHAT IT MEANS IS THAT THEY WILL MEET WITH COUNTY OFFICIALS, THE DEPARTMENT, I'VE ALREADY MET WITH THEM FOR ABOUT AN HOUR, THEY'LL BE MEETING WITH NAVIGANT, THEY'RE MEETING WITH MR. JANSSEN TOMORROW MORNING, THEY MET WITH-- A MEETING WITH WITH COUNTY COUNSEL THIS AFTERNOON TO LOOK AT THE VARIOUS PARAMETERS. THEY CERTAINLY COULD BE AVAILABLE TO MEET WITH BOARD MEMBERS IF YOU SO DESIRE. THEY'RE GOING TO MEET WITH THE TWO HEALTH SYSTEMS THAT HAVE SHOWN INTEREST TO UNDERSTAND UNDER WHAT CONDITIONS THEY MIGHT BE INTERESTED AND THEN I THINK THEIR JOB IS TO BEGIN TO PULL THAT ALL TOGETHER TO SEE IF THERE'S A-- YOU KNOW, A SOLUTION IN THERE THAT WOULD BE HELPFUL TO MAINTAINING THE SERVICES IN THE REGION SURROUNDING KING DREW MEDICAL CENTER OR AT KING DREW MEDICAL CENTER. 

SUP. MOLINA, CHAIR: AND SO RIGHT NOW IT IS ONLY WITH THE TWO THAT HAVE EXPRESSED INTEREST? 

DR. THOMAS GARTHWAITE: THAT'S CORRECT, ALTHOUGH THEY'VE SHOWN-- THEY'VE RAISED THE ISSUE OF POTENTIALLY CONTACTING OTHERS, I THINK. ONCE THEY'VE DONE THE INITIAL SET OF INTERVIEWS, THEY MIGHT-- THEY WOULD CONSIDER APPROACHING OTHERS THAT MIGHT BE INTERESTED. 

SUP. MOLINA, CHAIR: NOW, AGAIN, I HAVE NO OBJECTION TO LOOKING AND TRYING TO UNDERSTAND, DIDN'T KNOW WE WERE GOING TO BE HIRING A CONSULTANT FIRM IN ORDER TO DO THIS, SO-- BUT IF YOU JUST LOOK AT ALL THINGS BEING EQUAL, WHEN WE TRIED TO DO THIS WITH RANCHO LOS AMIGOS, WHO HAD NO ACCREDITATION PROBLEMS, WHO WAS A PREMIER ORGANIZATION, WHO DID HAVE A REVENUE STREAM COMING IN, WHO HAD A CAMPUS THAT HAD MUCH NEWER FACILITIES AND WE DIDN'T GET ANYTHING BACK, WHY WOULD THIS-- WHY-- IT SEEMS AS THOUGH YOU'RE JUST, LIKE, THROWING PEOPLE OUT TO WALK AROUND IN THE DARK. I MEAN, WHY WOULD YOU THINK-- WHAT WOULD BE-- WHAT ARE WE PUTTING ON THE TABLE OR-- OTHER THAN A DESIRE? WHAT IS IT THAT YOU SEE THAT MIGHT BE APPEALING TO SOMEBODY? 

DR. THOMAS GARTHWAITE: I THINK, IN THE CASE OF RANCHO, IF RANCHO CLOSES, IT DOESN'T AFFECT SO MANY OF THE PRIVATE INSTITUTIONS AS MUCH AS IF KING DREW MEDICAL CENTER WERE TO CLOSE. I THINK IT WOULD HAVE A DRAMATIC AFFECT ON SOME OF THE NEIGHBORING INSTITUTIONS. INDEED, THE INDIVIDUALS INTERESTED SO FAR IN TRYING TO EXPLORE THIS WITH US ARE INDIVIDUALS WHO OPERATE HOSPITALS NOT TOO FAR FROM KING DREW MEDICAL CENTER WHO WOULD BE SIGNIFICANTLY IMPACTED IF IT WERE TO CLOSE. SO I THINK THAT'S AT LEAST PART OF THE INTEREST. 

C.A.O. JANSSEN: SUPERVISOR, THERE IS ONE OTHER REASON THAT COMES TO MIND ALSO. IN RANCHO, WE WERE TRYING TO SAVE, AS I RECALL, $64 OR $65 MILLION, SO THAT LIMITED THE INTEREST RIGHT THERE. AT KING, WE'RE NOT LOOKING, AT THIS POINT TO SAVE MONEY. SO, IN TERMS OF ANYONE'S INTEREST, YOU WOULD PRESUME THAT IT WOULD BE VERY MUCH DIFFERENT. THE DIFFICULTY WITH KING IS THAT IT'S KING, NOT THE MONEY. AND THE DECISION TO HIRE A CONSULTANT WAS MY DECISION, SUPERVISOR. I THOUGHT IT WAS IMPORTANT TO GET SOME OBJECTIVE HELP IN WHAT IS OBVIOUSLY A VERY DIFFICULT SITUATION FOR YOUR BOARD AND FOR THE COMMUNITY AND THAT'S WHY WE BROUGHT THEM IN. 

SUP. MOLINA, CHAIR: NO, AND I CAN APPRECIATE THAT. I JUST DON'T KNOW WHAT THEY'RE DOING. I MEAN, GOING OUT AND MEETING AND TALKING TO PEOPLE, I CAN DO THAT ALL DAY LONG. BUT I JUST DON'T KNOW EXACTLY WHAT THEY'RE DOING AND UNDER WHAT-- YOU KNOW, LIKE, WHAT ARE THE PARAMETERS? FOR EXAMPLE, YOU KNOW, HOW MANY BEDS? WHAT, YOU KNOW, CERTAINLY NOT GOING TO BE A TEACHING HOSPITAL, RIGHT? I MEAN, THERE MUST BE SOME PARAMETERS. 

C.A.O. JANSSEN: WE HAVE A SCOPE OF WORK THAT... 

SUP. MOLINA, CHAIR: YOU DO HAVE A SCOPE OF WORK? 

C.A.O. JANSSEN: WE DO HAVE A SCOPE OF WORK AND... 

SUP. MOLINA, CHAIR: IS IT INCLUDED BEING A TEACHING HOSPITAL? 

DR. THOMAS GARTHWAITE: IT'S NOT SPECIFIED, I DON'T BELIEVE, AT THIS POINT. 

SUP. MOLINA, CHAIR: WELL, WHAT KIND OF BROAD SCOPE IS THIS? 

C.A.O. JANSSEN: WELL, YOU HAVE TO UNDERSTAND, THERE IS NO MODEL HERE IN THE NATION FOR WHAT WE'RE DOING. IT'S NOT LIKE THERE'S A CLEAR PATHWAY TO WHAT TO DO ABOUT MARTIN LUTHER KING. THERE IS NOT. THERE ARE MAYBE-- AND THE ATTORNEYS ARE GOING TO DRIVE A LOT OF WHAT IS LEGALLY POSSIBLE, NUMBER ONE. NUMBER TWO, WE HAVEN'T BEEN STAMPEDED BY INTEREST FROM THE PRIVATE SECTOR TO COME IN AND HELP US AT M.L.K. AND WE WANT TO EXPLORE WHAT OTHER LEGAL AND/OR QUASI-LEGAL OPTIONS THERE ARE TO BRING BACK TO YOU SO THAT YOU CAN HAVE OTHER THINGS YOU CAN LOOK AT OTHER THAN WHAT WE'RE DOING RIGHT NOW. 

SUP. MOLINA, CHAIR: I UNDERSTAND THAT, WHICH IS WHY I'M ASKING THE QUESTION. IT WOULD SEEM TO ME THAT WE KNOW EXACTLY WHAT WE NEED. NOW, WHETHER ANYBODY CAN FILL THE BILL, I'M NOT SURE, BUT IT SEEMS TO ME THAT WE KNOW EXACTLY WHAT WE NEED. THERE'S NO DOUBT THAT THERE COULD PROBABLY BE REFINED ALONG THE WAY, FROM THE STANDPOINT OF EXACTLY WHAT IT IS, BUT MY CONCERN IS, IT LOOKS LIKE WE'VE JUST TOSSED SOMETHING OUT THERE AND THESE FOLKS ARE GOING TO BE INTERVIEWING A LOT OF PEOPLE TO SEE OR GET A SENSE OF WHAT IT IS WE THINK WE WANT AND SEE MAYBE WHAT THEY COULD BRING US BACK. AND WHAT MY CONCERN IS THAT WE'RE SORT OF DEALING WITH A TIME FRAME HERE, RIGHT? FOR EXAMPLE, YOU HAVE A REPORT THAT'S DUE TO US IN, WHAT, TWO WEEKS? THREE WEEKS? 

C.A.O. JANSSEN: ABOUT A MONTH. RIGHT. ABOUT A MONTH. 

SUP. MOLINA, CHAIR: IN A MONTH. AND, IN THAT REPORT, THERE'S SUPPOSED TO BE HOPEFULLY A SERIES OF RECOMMENDATIONS IN WHICH IT TELLS US HOW WE WILL PROCEED FORWARD. IT WILL HAVE ISSUES AS TO HOW WE PROCEED FORWARD WITH DREW. IT WILL HAVE ISSUES AS TO HOW WE PROCEED FORWARD WITH THE PATIENT BEDS AT M.L.K. IT WILL PROBABLY HAVE HOW WE SHOULD PROCEED FORWARD WITH THE FACILITY ITSELF. RIGHT? BECAUSE THAT'S ON THE TABLE AT THAT TIME. 

C.A.O. JANSSEN: THAT'S ON THE TABLE. 

SUP. MOLINA, CHAIR: SO THERE'S A SERIES OF RECOMMENDATIONS THAT ARE GOING TO COME TO US. 

DR. THOMAS GARTHWAITE: CORRECT. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO I JUST DON'T-- I JUST DON'T KNOW WHAT THE TIME FRAME IS FOR SOMETHING LIKE THIS BUT... 

DR. THOMAS GARTHWAITE: THEIR TIME FRAME IS TO HAVE A REPORT BY AUGUST 2ND SO IT'S WELL WITHIN-- WE'VE GEARED THIS TO PRODUCE SOMETHING... 

SUP. MOLINA, CHAIR: WELL, YOU DIDN'T SAY THAT BEFORE. SO, BY AUGUST 2ND... 

DR. THOMAS GARTHWAITE: RIGHT, THEY WILL PRODUCE THEIR, YOU KNOW, BASIC ASSESSMENT AND REPORT TO COINCIDE WITH OURS AND WE WILL COORDINATE THEM SO THAT THE... 

SUP. MOLINA, CHAIR: YOU SEE, THAT WAS MISSING. THAT WAS MISSING, TOM, I DIDN'T SEE THIS. IT SAYS, "MEETINGS ARE SCHEDULED FOR THIS WEEK", SO I JUST ASSUME, LIKE, THESE PEOPLE HAVE BEEN HIRED FOR A YEAR, THEY'RE GOING TO GO OUT AND WANDER IN THE DARK AND COME BACK ONE DAY WITH SOMETHING. 

DR. THOMAS GARTHWAITE: MY MISTAKE. YOU PROBABLY ASSUMED THE SOCIAL TIME FRAME. THIS IS A VERY ACCELERATED TIME FRAME. 

SUP. MOLINA, CHAIR: YES, I DID ASSUME THE USUAL TIME FRAME AND THE USUAL PROCESS, YOU KNOW, IT'S, LIKE, WANDER AROUND. 

SUP. KNABE: WELL, THE MOTION WAS VERY SPECIFIC, THOUGH, 'TIL AUGUST 2ND 

SUP. MOLINA, CHAIR: I UNDERSTOOD BUT IT DOESN'T HAVE ANY DETAILS THAT WE UNDERSTAND HERE AS TO HOW IT'S GOING TO PROCEED FORWARD. AND THAT'S WHY I'M RAISING THOSE ISSUES. ALL RIGHT. I DON'T HAVE ANY OTHER QUESTIONS AND, MR. HENRY, I DON'T KNOW WHERE THE HECK YOUR REPORT IS. THEY GOT IT TO ME BUT I'LL LOOK AT IT A LITTLE LATER. I'M SURE I'LL HAVE ISSUES WITH IT BUT WE ALSO HAVE ANOTHER REPORT BECAUSE I DO HAVE QUESTIONS TO ASK WITH REGARD TO-- WHICH IS ITEM 66, WHICH IS THE PHYSICIAN MANAGEMENT PERFORMANCE EVALUATION AND WORKLOAD REPORTS, WHICH ARE BASICALLY ISSUES THAT MR. HENRY SHOULD TAKE INTEREST IN. THANK YOU. I DON'T KNOW, IS DR. CHERNOF GOING TO PRESENT THIS? I'M SORRY, DID YOU HAVE OTHER QUESTIONS? 

SUP. KNABE: I JUST-- YEAH, I JUST WANTED TO FOLLOW UP WITH TOM IN REGARDS TO THE AFFILIATION REPORTS. YOUR REPORT INDICATED, OBVIOUSLY, THAT, YOU KNOW, LAST WEEK, DREW WAS FINE IN REGARDS TO, YOU KNOW, NOT SHARING INFORMATION WITH THE COUNTY. I GUESS THE CONCERN THAT I HAVE, I MEAN, THE WHOLE WORLD'S WATCHING. DO THEY THINK THAT WE DON'T CARE? OR MAYBE YOU COULD EXPLAIN IT TO ME. I JUST-- YOU KNOW, I THINK WE WERE EXPECTING MORE RESULTS OTHER THAN EXCUSES. 

DR. THOMAS GARTHWAITE: YEAH, I THINK WE'VE, BY AND LARGE, HAVE GOTTEN THE REPORTS THAT WERE DUE US FROM DREW. WE THINK THERE WAS ONE THAT WAS DELAYED BY A WEEK OR SO. THERE IS ONE PARTICULAR ASSESSMENT, WHICH WE REJECTED THE ORIGINAL REPORT AND WE'VE NOT RECEIVED AN IMPROVED REPORT. BUT WE THINK THAT THAT WILL BE EASIER NOW WITH THE NEW DESIGNATED INSTITUTIONAL OFFICIAL THAT HAS JUST TAKEN OVER. WE THINK WE CAN WORK THROUGH THAT ISSUE PRETTY EASILY. SO I THINK, YOU KNOW, WE HAVE GOTTEN MOST OF THE REPORTS, I WOULD SAY. I MEAN, BRUCE... 

SUP. KNABE: I MEAN, I UNDERSTAND THAT, TOM, BUT, I MEAN, YOU KNOW, YOU TELL US EVERYTHING'S MOVING ALONG, IT'S GOING TO GET BETTER AND THINGS LIKE THAT AND THEN WE GET A REPORT SAYING YOU FINED THEM. I MEAN, YOU KNOW, SOMETHING'S... 

DR. BRUCE CHERNOF: FROM MY PERSPECTIVE, SINCE I'VE BEEN MONITORING THE REPORTS FOR THE DEPARTMENT, WE'VE SEEN A SIGNIFICANT IMPROVEMENT. I THINK, FRANKLY, THE BIGGEST CHALLENGE HAS BEEN THAT THE EXECUTIVE LEADERSHIP AT THE SCHOOL, WHICH HAS NOW BEEN REPLACED, WAS RESISTANT TO PROVIDING CERTAIN KINDS OF INFORMATION ON A TIMELY BASIS. WE DIDN'T HAVE A KIND OF DIALOGUE THAT WAS EFFECTIVE. WE NOW HAVE NEW LEADERSHIP IN PLACE IN TWO CRITICAL POSITIONS: THE PROVOST POSITION AND THE D.I.O. POSITION AND THE D.I.O. POSITION IS CRITICAL WITH RESPECT TO THESE REPORTING REQUIREMENTS BECAUSE THEY LOOK AT THE OVER-- THE DAY-TO-DAY OVERSIGHT AND MONITORING OF THE TRAINING PROGRAMS, HOW ACTIVE ISSUES ARE BEING ADDRESSED, WHICH ISSUES ARE THE MOST IMPORTANT AND WE NOW HAVE EXTREMELY GOOD NEW LEADERSHIP IN THE D.I.O. POSITION, SOMEBODY WHO HAS A DEMONSTRATED TRACK RECORD AT THIS FACILITY IDENTIFYING, FIXING PROBLEMS FROM... 

SUP. MOLINA, CHAIR: WHAT DOES THAT STAND FOR? 

DR. BRUCE CHERNOF: DESIGNATED INSTITUTIONAL OFFICER. IT IS THE A.C.G.M.E.'S TITLE FOR THE INDIVIDUAL WHO IS RESPONSIBLE FOR THE SUPERVISION OF ALL THE TRAINING PROGRAMS IN A FACILITY. 

SUP. MOLINA, CHAIR: AND WHO IS THAT? 

DR. BRUCE CHERNOF: DR. NANCY HANNA, H-A-N-N-A. SHE LED THE TURNAROUND OF THE DEPARTMENT OF MEDICINE TRAINING PROGRAMS WHERE THEY HAD MULTIPLE CITATIONS TO THE POINT WHERE THEY ARE NOW PROGRAMS WITH COMMENDATION, ACCREDITED WITH COMMENDATION. 

SUP. MOLINA, CHAIR: ALL RIGHT. WELL, I HAVE QUESTIONS. WE HAD ASKED A LONG TIME AGO THAT WE START GETTING INFORMATION BECAUSE WE ARE VERY CONCERNED ABOUT THE PHYSICIANS AND THEIR EVALUATIONS AND THEIR PERFORMANCE EVALUATIONS AND THE MANAGEMENT AND YET THE REPORT DOESN'T GIVE US ANY REAL INSIGHT OF ANY CHANGE. IT LOOKS LIKE YOU'RE GOING TO DO THE SAME THING THAT'S ALWAYS BEEN DONE. WHAT IS INNOVATIVE OR DIFFERENT OR NEW IN YOUR REPORT? 

DR. THOMAS GARTHWAITE: I'LL LET BRUCE... 

DR. BRUCE CHERNOF: I THINK THE KEY CHANGES HERE ARE, FIRST OF ALL, THE MOVEMENT OF PHYSICIAN REVIEW USING THE COUNTY'S PROCESS FROM BIANNUAL TO ANNUAL WAS A VERY IMPORTANT STEP. 

SUP. MOLINA, CHAIR: WITH WHO? 

DR. BRUCE CHERNOF: I'M SORRY, SUPERVISOR? 

SUP. MOLINA, CHAIR: THE MOVEMENT OF PHYSICIANS WITH WHO? 

DR. BRUCE CHERNOF: THE OVERSIGHT OF THE PERFORMANCE EVALUATIONS FROM BEING EVERY OTHER YEAR TO YEARLY. 

SUP. MOLINA, CHAIR: THEY NEVER DID THEM EVERY OTHER YEAR SO WHY WOULD THEY DO THEM NOW EVERY YEAR? 

DR. BRUCE CHERNOF: THERE IS AN ACTIVE PROCESS THAT'S BEEN PUT IN PLACE BY THE DEPARTMENT'S HUMAN RESOURCE STAFF TO MONITOR THE COMPLETE PERFORMANCE EVALUATIONS ARE BEING DONE ON AN ANNUAL BASIS, THAT ALL OF THE OTHER REQUIRED PAPERWORK, WHICH IS UNIQUE TO BEING A PHYSICIAN AS OPPOSED TO OTHER KINDS OF COUNTY EMPLOYEES, THE OUTSIDE EMPLOYMENT DOCUMENTATION... 

SUP. MOLINA, CHAIR: BUT WHAT IS THE DIFFERENCE? I MEAN, THEY WERE DUE EVERY OTHER YEAR BEFORE AND THEY NEVER GOT DONE, SO WHAT MAKES YOU THINK THEY'RE GOING TO GET DONE TODAY? 

DR. BRUCE CHERNOF: BECAUSE THERE'S STAFF AND PROCESS IN PLACE TO MAKE SURE THAT THAT'S... 

SUP. MOLINA, CHAIR: SO THERE WAS NEVER STAFF TO DO EVALUATIONS BEFORE, IS THAT WHAT YOU'RE TELLING ME? 

DR. BRUCE CHERNOF: NO, THERE WAS STAFF IN PLACE BUT I DON'T THINK THE PROCESS WAS AS AGGRESSIVE OR COMPREHENSIVE AS THE ONE THAT'S BEEN PUT IN PLACE. 

SUP. MOLINA, CHAIR: SO IF SOMEBODY SAYS EVALUATIONS. SO YOUR SUPERVISOR, YOU'RE IN CHARGE OF 10 PHYSICIANS AND YOU'RE IN CHARGE-- AND YOU'RE SUPPOSED TO DO THE PROCESS, YOU HAVE TO DO THESE EVALUATIONS EVERY OTHER YEAR, NOBODY HAS TO PAY ATTENTION TO THAT? 

DR. BRUCE CHERNOF: I'M NOT SAYING THAT, SUPERVISOR. 

SUP. MOLINA, CHAIR: I'M SORRY? 

DR. BRUCE CHERNOF: I'M NOT SAYING THAT, SUPERVISOR. THEY SHOULD BE FOLLOWED. 

SUP. MOLINA, CHAIR: SO, ALL RIGHT, AGAIN, THE REASON THAT IT'S NOW GOING TO WORK, WHY? I MEAN, WE HAD THE RULE BEFORE. WE HAD THE PROCESS IN PLACE BEFORE. WHY IS IT GOING TO WORK NOW? 

DR. BRUCE CHERNOF: WITH THE NEW E-CAPS SYSTEM AND THE OTHER MONITORING SYSTEMS, WE CAN KEEP TRACK ON AN ELECTRONIC BASIS AS OPPOSED TO JUST LOOKING AT PAPER AND FILES, WHICH IS MUCH HARDER TO AUDIT SYSTEMATICALLY. 

SUP. MOLINA, CHAIR: SO NOW YOU'RE GOING TO BE ABLE TO KEEP IT ON A COMPUTER SO THAT PEOPLE WILL KNOW WHEN IT'S NOT IN? 

DR. THOMAS GARTHWAITE: IT WILL REPORT SPECIFICALLY TO THE SUPERVISORS TO TELL THEM THEIR PROGRESS. WE CAN GENERATE LISTS FOR UPPER MANAGEMENT TO SAY WHO HAS DONE THE WORK AND WHO HASN'T AND HOW LONG IT'S OVERDUE. 

SUP. MOLINA, CHAIR: TELL ME, DR. CHERNOF, IF I HAVE A DOCTOR UNDER MY SUPERVISION AND I DON'T THINK HE'S DOING VERY WELL, HOW DO I HANDLE HIM OR HER? 

DR. BRUCE CHERNOF: DEPENDS ON THE SPECIFIC ISSUE. ONE COMPONENT... 

SUP. MOLINA, CHAIR: ANY ISSUE. HE BEHAVES BADLY. ONE OF THE THINGS YOU JUST SAID, DR. GARTHWAITE. 

DR. BRUCE CHERNOF: SURE. BEHAVIOR ISSUES WOULD BE DEALT WITH AS WE WOULD ANY OTHER PERFORMANCE ISSUE FOR ANY OTHER COUNTY EMPLOYEE. THE ONE THING THAT MAKES PHYSICIANS A LITTLE UNIQUE AND DIFFERENT IS THE PEER REVIEW PROCESS, THE ABILITY TO OVER... 

SUP. MOLINA, CHAIR: NO, NO. I'M THE MANAGER. TELL ME WHAT I DO. 

DR. BRUCE CHERNOF: YOU WOULD GO THROUGH THE NORMAL COUNTY PROCESS. 

SUP. MOLINA, CHAIR: WHICH IS? 

DR. BRUCE CHERNOF: SUPERVISING THAT PHYSICIAN, YOU WOULD GIVE DIRECT FEEDBACK TO THAT PHYSICIAN ABOUT THE BEHAVIOR. 

SUP. MOLINA, CHAIR: I CAN TAKE HIM ASIDE AND SAY, "YOU'RE BEHAVING BADLY," IS THAT CORRECT? 

MICHAEL HENRY: THERE'S MORE YOU CAN DO THAN THAT. I MEAN, YOU CAN-- CERTAINLY, THAT'S PART OF IT IS COUNSELING BUT YOU ALSO HAVE THE ABILITY TO TAKE ACTIONS AGAINST THE INDIVIDUAL. 

SUP. MOLINA, CHAIR: OH, YOU CAN TAKE ACTION? 

SPEAKER: SURE, YOU CAN. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO LET'S SAY THAT I FIND SOMEBODY CHEATING ON A TIMECARD. WHAT CAN I DO? 

DR. BRUCE CHERNOF: YOU CAN-- THERE'S A WHOLE RANGE OF ACTIONS THAT RANGE FROM... 

SUP. MOLINA, CHAIR: I'M THE SUPERVISOR. 

DR. BRUCE CHERNOF: YOU CAN PUT SOMEBODY OUT ON LEAVE. 

SUP. MOLINA, CHAIR: YOU CANNOT. THAT IS NOT TRUE. 

DR. BRUCE CHERNOF: ONCE THE INVESTIGATION IS DONE. 

SUP. MOLINA, CHAIR: AH, THE INVESTIGATION. LET'S TALK ABOUT THAT. HOW LONG DOES THE INVESTIGATION-- HOW DO I GET THE INVESTIGATION? I CAN INVESTIGATE? 

DR. BRUCE CHERNOF: AS A MANAGER, YOU WOULD BE EXPECTED TO START THE INVESTIGATION BUT YOU WOULD WORK WITH THE HUMAN RESOURCE STAFF IN THE FACILITY TO COMPLETE IT AND WITH THE DEPARTMENT OF HUMAN RESOURCES AS NECESSARY... 

SUP. MOLINA, CHAIR: YOU KNOW THAT'S NOT TRUE, DR. CHERNOF. IT'S NOT TRUE. I TRACED YOUR TIMECARD FRAUD INVESTIGATIONS. THOSE WERE REPORTED AND THE MANAGING SUPERVISING DOCTOR HAD NO ABILITY TO KNOW BECAUSE, UNDER AN INVESTIGATION, THEY ARE NOT PERMITTED TO KNOW WHAT IS GOING ON IN ANY KIND OF VIOLATION OF THAT TYPE. DID YOU KNOW THAT, MR. HENRY? 

MICHAEL J. HENRY: UNTIL IT'S COMPLETED AND... 

SUP. MOLINA, CHAIR: AND UNTIL IT'S COMPLETED. AND THE DAY IT'S COMPLETED, THE SUPERVISOR DOESN'T HAVE TO KNOW. YOU DON'T-- THERE'S NOTHING IN YOUR RULES... 

MICHAEL J. HENRY: YOU DON'T HAVE TO TELL THEM. THAT'S RIGHT. 

SUP. MOLINA, CHAIR: NO, IT'S NOT TRUE. 

MICHAEL J. HENRY: NO, I SAID, IT IS TRUE, YOU DON'T HAVE TO DISCLOSE. 

SUP. MOLINA, CHAIR: SO THEY DON'T KNOW. SO HERE IT IS, SOMEBODY IS LYING ON THEIR TIMECARD, I'M THEIR SUPERVISOR, I HAVE TO SEND IT TO INVESTIGATIONS. COULD TAKE TWO WEEKS TO 2-1/2 YEARS. DID YOU KNOW THIS, DR. CHERNOF? 

DR. BRUCE CHERNOF: THIS LEVEL OF DETAIL HAVING BEEN HERE SIX MONTHS... 

SUP. MOLINA, CHAIR: OH, I'VE BEEN INVOLVED IN THIS LEVEL OF DETAIL. SIR, THE REASON I'M ASKING IS WE ASKED FOR THIS LEVEL OF DETAIL IN THIS REPORT. MAKING PRONOUNCEMENTS OF WHAT IS, IS NOT SUFFICIENT. YOU REALLY HAVE TO GET INVOLVED INTO THE DETAIL OF THESE ISSUES. REALLY HAVE TO GET INVOLVED. IN THE TIMECARD FRAUD ISSUES, THAT'S WHAT HAPPENED. YOU HAD A GOOD SUPERVISOR WHO SAID, "I KNOW THESE GUYS ARE CHEATING" BUT HE'S NOT ALLOWED TO DO ANYTHING, NOT ONE THING, DR. GARTHWAITE. HE CAN'T EVEN LOOK AT THEM, HE CAN'T EVEN SAY TO THEM, "NEXT TIME I'D LIKE YOU TO SHOW UP ON THE DAY YOU'RE SUPPOSED TO BE HERE." HE CANNOT DO THAT. IT'S AGAINST THE RULES. HE HAS TO CALL UP SOMEBODY IN AUDITING AND ASK FOR AN INVESTIGATION. IT GOES TO AUDITING. THEY PUT IT ON WHATEVER STACK THEY HAVE OF THINGS TO DO AND IT GETS INVESTIGATED. TWO WEEKS, SIX MONTHS, TWO YEARS. IT GETS DONE. IN THE MEANTIME, THIS DOCTOR IS WORKING THERE UNDER THE SUPERVISION OF THIS OTHER AND HE IS NEVER TOLD THAT THE INVESTIGATION IS GOING TO BE COMPLETED IN TWO WEEKS, SIX MONTHS OR TWO YEARS. NO RESOLUTION. THE GUY KEEPS CHEATING, HE KEEPS CHEATING, HE KEEPS CHEATING AND THE MANAGER DOESN'T KNOW. THAT'S OUR RULES. NOW HOW CAN THAT BE-- HOW CAN YOU MANAGE SOMEONE THAT WAY? HOW COULD YOU MANAGE SOMEBODY THAT WAY? 

DR. BRUCE CHERNOF: GENERALLY, THE SUPERVISOR WOULD BE THE INDIVIDUAL SIGNING OFF ON THE TIMECARD, SO IT WOULD BE VERY HARD FOR THEM TO NOT BE AWARE AND OFTENTIMES THE TIMECARD PROBLEMS ARE IDENTIFIED BY THE SUPERVISOR... 

SUP. MOLINA, CHAIR: I'M TELLING YOU, HE'S SIGNING OFF ON A TIMECARD. THE GUY WROTE EIGHT HOURS AND HE KNOWS THAT IT WASN'T EIGHT HOURS. HE CAN'T DO ANYTHING ABOUT IT. HE HAS TO SIGN THE TIMECARD. RIGHT, MR. HENRY? 

MICHAEL J. HENRY: HE'S GOT TO BE INVESTIGATED. UNTIL THE INVESTIGATION IS COMPLETED... 

SUP. MOLINA, CHAIR: DO YOU UNDERSTAND THE CIRCLE I'M TAKING YOU AROUND? YOU'RE MANAGING THIS GUY, YOU HAVE TO SIGN HIS TIMECARD, HE'S BROUGHT IT TO YOU, YOU KNOW IT'S NOT VALID, YOU CAN'T DO ANYTHING ABOUT IT OTHER THAN TO SEND IT TO INVESTIGATIONS. I REALLY THINK IT'S WORTH YOUR WHILE TO MAYBE GET INTO THE DETAILS. THE REASON IS, IS THAT'S WHERE WE'RE LOSING THE REAL SENSE OF IT. JUST TELLING SOMEBODY SHOULD DO PERFORMANCE EVALUATIONS EVERY YEAR, WITH ALL DUE RESPECT, IT'S NOT GOING TO GET US TO GOAL, SIR. 

DR. THOMAS GARTHWAITE: I BELIEVE SOME OF THE ISSUES YOU'RE BRINGING UP, WHICH I AGREE WITH AND THAT THEY'RE REAL PROBLEMS, WE'LL BE MORE THAN HAPPY TO TRY TO WORK WITH H.R. TO CHANGE SOME OF THOSE. I DON'T BELIEVE THEY'RE ALL DEPARTMENTAL ISSUES BUT I THINK THAT WE'D LOVE TO CHANGE... 

SUP. MOLINA, CHAIR: YEAH, BUT DR. GARTHWAITE, YOU KNOW, I JUST POINTED IT OUT TO YOU AND WE DID THIS MOTION IN DECEMBER OF LAST YEAR. OKAY? AND YOU'RE GIVING ME A REPORT, AND THE REPORT DOESN'T EVEN CONTAIN THIS. I WENT OUT AND HAD ONE MEETING WITH DR. ISHIKAWA. VERY DECENT GUY. AND FOUND OUT THAT THERE'S THIS-- THERE'S THIS PROCESS THAT GOES ON FOREVER AND EVER. HE DOESN'T EVEN KNOW. AND CAN'T KNOW, BY OUR OWN RULES. SO HOW CAN HE EVALUATE THIS DOCTOR WHEN HE HAS TO GO THROUGH THIS PROCESS AND THEN THERE'S ALL THESE OTHER KINDS OF THINGS? NOW, I WANT TO BE FAIR TO FOLKS BUT THINK ABOUT IT. SO YOU'VE GIVEN ME A REPORT ABOUT TELLING ME NOW THEY'RE ALL GOING TO DO THESE THINGS. I'M SUPPOSED TO BELIEVE IT. WHEN WILL YOUR NEXT REPORT BE OUT? 

DR. BRUCE CHERNOF: WE CAN SET THEM UP QUARTERLY, IF YOU'D LIKE. 

SUP. MOLINA, CHAIR: WELL, YOU KNOW, REPORTING IS REPORTING. I GET A LOT OF INFORMATION THAT DON'T MEAN ANYTHING. DR. CHERNOF, I'M TRYING TO POINT OUT SOMETHING THAT I REALLY THINK YOU HAVE TO GO BACK TO THE DRAWING BOARD. WITH ALL DUE RESPECT TO THIS REPORT, YOU TELL ME WHAT I ALREADY KNOW. WE ALREADY KNOW ABOUT PEER REVIEW, WE ALREADY KNOW ABOUT PERFORMANCE EVALUATIONS. I THINK YOU NEED TO GET INTO THE DETAILS OF MANAGING PHYSICIANS. I'M REALLY CONCERNED ABOUT THAT AND THAT IS THAT YOU NEED TO EMPOWER PEOPLE. NOW, IF THAT MEANS CHANGING RULES, PLEASE WRITE US A REPORT. THIS BOARD WOULD LOVE TO CHANGE THE RULES IF IT'S GOING TO BRING ABOUT GREATER ACCOUNTABILITY BUT TRYING TO TELL ME THAT NOW, INSTEAD OF EVERY TWO YEARS THEY'RE GOING TO DO IT EVERY YEAR, THEY DIDN'T DO IT FOR THE LAST 20 YEARS EVERY TWO YEARS. I MEAN, WHAT AM I SUPPOSED TO BELIEVE IN THE SYSTEM TODAY THAT TELLS ME THAT IT'S GOING TO CHANGE? BUT IT'S MORE ABOUT MANAGING THE PHYSICIANS, IT'S ABOUT ACCOUNTABILITY AND I DON'T KNOW HOW ELSE I'M SUPPOSED TO KNOW. THE ONLY REASON I KNOW WHAT I DID KNOW IS BECAUSE I WENT OVER AND TALKED TO DR. ISHIKAWA DIRECTLY. 

DR. THOMAS GARTHWAITE: SUPERVISOR, I'D JUST THAT, IN THE JUNE OF 2002 REPORT THAT WE PUT FORWARD TO THIS BOARD THAT HAD THE SCENARIOS THAT YOU ALL REMEMBER BECAUSE OF THE BUDGE ISSUE, THERE WAS A CLEAR RECOMMENDATION FROM THE DEPARTMENT, FROM ME SPECIFICALLY THAT WE NEEDED A NEW HUMAN RESOURCES SYSTEM, ESPECIALLY FOR PHYSICIANS AND OTHER PROFESSIONALS. AND I WORKED FOR A COUPLE YEARS WITH THE GENTLEMAN TO MY LEFT, MR. HENRY, AT WHICH POINT HIS ADVICE TO ME WAS HE TOLD ME THAT THERE DID NOT SEEM TO BE ANY WAY, SHORT OF AMENDING CIVIL SERVICE CODE, WHICH TOOK TWO-THIRDS OF THE ELECTORATE TO APPROVE, AND... 

SUP. MOLINA, CHAIR: THAT IS NOT TRUE. MR. HENRY, MR. HENRY-- NO, NO, DR. GARTHWAITE, JUST A MINUTE, LET ME... 

DR. THOMAS GARTHWAITE: JUST TELLING YOU WHAT HAPPENED. 

SUP. MOLINA, CHAIR: ...JUST TELL YOU THIS. WE HAVE BEEN WAITING FOR ANY OF YOU TO BRING TO US SOME REAL CHANGES. THERE IS NO REASON... 

DR. THOMAS GARTHWAITE: WELL, WE'D BE HAPPY TO DO THAT. 

SUP. MOLINA, CHAIR: WAIT, WAIT. THERE IS NO REASON FOR A TIMECARD FRAUD INVESTIGATION TO TAKE TWO YEARS. THAT'S NUMBER ONE. ALL RIGHT? A TIMECARD FRAUD INVEST... 

DR. THOMAS GARTHWAITE: WHAT I PUT FORWARD WAS NOT JUST A TIMECARD FRAUD ISSUE. 

SUP. MOLINA, CHAIR: NO, BUT THIS IS ONE OF THE BIG ISSUES, WHEN DOCTORS ARE NOT WORKING WHEN THEY'RE SUPPOSED TO BE WORKING. I MEAN, WHEN A NURSE IS SLEEPING ON THE JOB AND GETS TO GO HOME WITH PAY FOR A YEAR BECAUSE INVESTIGATIONS ARE TAKING TOO LONG. INVESTIGATIONS SHOULD BE TURNED AROUND IN A SHORT PERIOD OF TIME. IT EITHER IS OR IT ISN'T. THIS GOES ON IN THE SHERIFF'S DEPARTMENT, IT GOES ON IN PROBATION, WHERE INVESTIGATIONS ARE TAKING MUCH TOO LONG. THE POINT IS, DON'T TELL ME THAT WE CANNOT CHANGE CERTAIN RULES. THERE IS NO REASON. IF I AM A SUPERVISOR AND I ASK SOMEONE TO BE INVESTIGATED, IF I AM IN CHARGE OF THEIR PERFORMANCE, WHY I CANNOT BE INFORMED. THERE IS NOTHING IN CIVIL SERVICE THAT SAYS I CANNOT BE INFORMED, MR. HENRY, NOT ONE DAMN RULE. BUT YOU GUYS MAKE THEM UP ALONG THE WAY. HE SHOULD HAVE BEEN INFORMED. BUT WE HAVE A PROCESS THAT SAYS THAT HE CAN'T BE INFORMED. THAT'S NOT SMART. THAT'S WHAT I'M TALKING ABOUT. YOU ALMOST NEED TO GO THROUGH THE DETAILS OF THESE ISSUES IN ORDER TO SORT OUT WHAT THE PROBLEMS ARE AND NOT JUST REGURGITATE WHAT WE ALREADY KNOW. I DON'T MEAN TO BE DISRESPECTFUL WITH YOU, DR. CHERNOF, I KNOW YOU JUST STARTED BUT THIS IS THE LEVEL OF DETAIL THAT YOU NEED TO GET INVOLVED IN IF WE'RE GOING TO HAVE ACCOUNTABILITY AND I'M NOT JUST TALKING ABOUT M.L.K. I MEAN, WE'VE HAD TIMECARD PROBLEMS AT L.A. COUNTY U.S.C. I DON'T KNOW ABOUT THE OTHER FACILITIES. AND, BELIEVE ME, I'M JUST AS SERIOUS ABOUT TIMECARD FRAUD AT L.A. COUNTY U.S.C. AS I AM ANYWHERE. WE DON'T WANT ANY DOCTOR CHEATING ON THEIR TIMECARD ON OUR COUNTY TIME. AND SO, CONSEQUENTLY, PERFORMANCE EVALUATIONS IS NOT GOING TO GET TO THE HEART OF THAT. I WANT SUPERVISORS THAT CAN SUPERVISE THEM AND YOU HAVE TO EMPOWER ME AS A SUPERVISOR. BUT IF YOU TAKE AWAY MY POWERS AND TELL ME THAT-- JUST GIVE ME RULES LIKE YOU WILL NOW DO AN EVALUATION EVERY YEAR, THAT DOESN'T CHANGE, IT DOESN'T EMPOWER ME TO REALLY MANAGE THIS INDIVIDUAL. BUT WHEN YOU HAVE RULES LIKE THE ONE THAT I JUST POINTED OUT TO YOU. AND THIS IS A PROCESSES THAT REALLY YOU SHOULD EXPLORE THOSE PROTOCOLS WITHIN THE DEPARTMENT. I DON'T KNOW IF IT WORKS THE SAME WAY AT EVERY HOSPITAL BUT I DO KNOW THAT, AT M.L.K., I ASKED THESE QUESTIONS AND THOSE WERE THE ANSWERS. I THINK YOU SHOULD ASK THE SAME QUESTIONS. ANYONE ELSE? THANK YOU VERY MUCH. 

SUP. BURKE: ON ITEM-- IS THIS ON ITEM... 

SUP. MOLINA, CHAIR: 66. 

SUP. BURKE: 66. I DID NOT GET AN OPPORTUNITY ON THE OTHER ISSUE BUT I WANT TO BE VERY CLEAR. I SUBMITTED, IN WRITING, MY QUESTION AND THEY PARTICULARLY DEALT WITH HUMPHREY AND SOME OF THE ISSUES THERE, SO I ASSUME THAT I'LL GET A RESPONSE BACK. AND I'VE SUBMITTED ALL OF MY QUESTIONS IN WRITING BECAUSE I PREFER TO GET A WRITTEN RESPONSE BACK AND I'D LIKE TO KNOW-- GET AN UPDATE ON IT. I DON'T NECESSARILY FEEL IT'S NECESSARY FOR ME TO GO THROUGH ALL OF THIS HERE. 

DR. THOMAS GARTHWAITE: THANK YOU. BE HAPPY TO PROVIDE IT IN WRITING. 

SUP. MOLINA, CHAIR: I GET BETTER ANSWERS, I'LL ASK THEM IN WRITING, TOO. DO YOU THINK I'LL GET BETTER ANSWERS IF I ASK THEM IN WRITING? I'LL TRY... 

DR. THOMAS GARTHWAITE: DEPENDS ON THE QUESTION, I GUESS. 

SUP. MOLINA, CHAIR: ...I'LL TRY YOU. 

SUP. BURKE: WELL, ONE THING IS, IF THEY DON'T-- IF YOU-- IF YOU'RE UNSATISFIED, YOU SEND THEM BACK AGAIN. I KNOW THAT WE HAVE-- WE'RE RESUBMITTING A COUPLE OF THOSE ISSUES AND WE EXPECT TO GET A RESPONSE. IN THIS AREA, I KNOW THAT WE'VE ALSO SUBMITTED QUESTIONS AS A RESULT OF ISSUES WE'VE RECEIVED-- ISSUES RAISED BY OTHER EMPLOYEES AT HOSPITALS. AND SOMETIMES WE GOT RESPONSES, SOMETIMES WE DID NOT GET THEM, BUT THESE DEALT WITH PERSONNEL ISSUES AND PARTICULARLY PEOPLE ORDERING SOMETHING THAT THE HOSPITAL COULDN'T USE. YOU KNOW WHICH ONE I'M REFERRING TO. SO, YOU KNOW, I THINK THAT SUBMITTING OF QUESTIONS IN WRITING DOES NOT HURT BUT WHAT AMAZES ME IS THAT, IN LOOKING BACK, I KNOW THERE ARE MANY DOCTORS WHO HAVE BEEN TERMINATED FROM KING OVER THE YEARS THAT I RECALL AND I GUESS I DON'T KNOW HOW THE MECHANISM WORKED BUT THEY WERE TERMINATED. 

SUP. ANTONOVICH: OBVIOUSLY NOT ENOUGH. 

SUP. BURKE: WELL, OBVIOUSLY NOT ENOUGH BUT THE FACT REMAINS IS THEY WERE TERMINATED. NOW, OF COURSE, SOME OF THEM WENT OVER TO ST. FRANCIS AND-- MOST OF THEM DID OR THEY'RE OVER IS THERE NOW BUT-- AND-- BECAUSE THE PROBLEM RELATED TO THEIR WORKING AT ST. FRANCIS. SO I KNOW THAT THEY'RE-- AND I COULD SIT DOWN HERE AND GIVE YOU NAMES OF PEOPLE AND YOU-- I THINK YOU KNOW WHO I MEAN. 

SUP. KNABE: YOU'RE TALKING ABOUT THE MOST RECENT. 

SUP. BURKE: NO, NO! TWO YEARS AGO, THREE YEARS AGO. I CAN GO THROUGH ONE PERSON AFTER ANOTHER WHO WAS TERMINATED FROM KING AND WHO HAVE GONE OVER TO ST. FRANCIS BECAUSE THAT'S WHERE MOST OF THEM HAVE-- THEY'RE ON THE STAFF THERE AND PARTICULARLY IN OB/GYN, WE WERE PROVIDING PRENATAL BUT THOSE DOCTORS REFERRED THOSE PATIENTS OVER TO ST. FRANCIS FOR DELIVERY. NOW, I DON'T KNOW WHETHER THAT'S GOING ON NOW BUT IT'S BEEN GOING ON FOR THE LAST FIVE YEARS. AND THEY'RE ON THE STAFF THERE AND THEY'RE DELIVERED THERE, AND THAT'S ONE REASON HOW ST. FRANCIS GOT ADDITIONAL DELIVERIES. SO-- AND, IN SOME INSTANCES, THESE PEOPLE WERE TERMINATED. MOST OF THEM, THEY WERE NOT TERMINATED, IT'S TRUE BUT SOME OF THEM WERE TERMINATED AND SO THEY JUST WENT THERE PERMANENTLY. CENTINELA, THE PERSON WHO WAS TERMINATED AND THAT WAS LAST YEAR, WENT OVER TO CENTINELA, WHERE THEY WERE ON THE STAFF, AND THAT PERSON IS WORKING AT CENTINELA AND THEY WERE TERMINATED. SO, I MEAN, I CAN GIVE YOU THE NAMES OF THESE PEOPLE SO THAT YOU CAN CHECK THEM OUT. THERE WERE TERMINATIONS THAT TOOK PLACE IF THEY WANT TO TERMINATE THEM AND I DON'T KNOW HOW THE SUPERVISOR GOT NOTICE OR WHO-- BUT EVERYBODY IN THE HOSPITAL KNEW AND THE INFORMATION GOT OUT TO EVERYONE. SO I'D BE VERY INTERESTED TO FIND HOW THIS ISSUE RESOLVES IN TERMS OF CHANGING OUR RULES OR WHATEVER, IN TERMS OF GETTING INFORMATION ABOUT TERMINATIONS. 

SUP. ANTONOVICH: I HAVE A QUESTION. 

SUP. MOLINA, CHAIR: SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: I GUESS THIS REPEATS A LITTLE FROM LAST WEEK BUT, WHEN A PERSON IS TERMINATED, DO WE THEN MAKE THAT NOTATION SO A FUTURE EMPLOYER, WHEN THEY WRITE TO THE COUNTY, WE WILL TELL THEM THEY WERE TERMINATED BECAUSE OF INCOMPETENCE? DO WE DO THAT EVERY TIME? MR. HENRY? 

DR. THOMAS GARTHWAITE: I THINK... 

MICHAEL J. HENRY: I DON'T THINK THAT WE DO. 

SUP. ANTONOVICH: I CAN'T HEAR YOU. 

MICHAEL J. HENRY: I'M SORRY. I DON'T THINK THAT WE DO. WE MAKE A NOTATION IN THE FILE OF WHAT THE PROCESS WAS AND WHAT WAS THE FINAL RESULTS, BE IT SUSPENSION, DISCHARGE, OR WHAT HAVE YOU. BUT I DON'T BELIEVE THAT YOU CAN-- THERE IS NEW LAW THAT YOU HAVE TO BE VERY CAREFUL OF WHAT YOU SAY TO ANOTHER EMPLOYER. 

SUP. ANTONOVICH: SO WE THINK THAT'S AN PROBLEM AND WE'RE GOING TO HAVE AN EXECUTIVE SESSIONS WITH COUNTY COUNSEL ON THIS POINT AND, I MEAN, THAT'S A PART OF THE LAW OR AN INTERPRETATION OF THE LAW THAT HAS TO BE CHANGED SO THAT A PERSPECTIVE EMPLOYER UNDERSTANDS THE ENTIRE BACKGROUND OF THAT EMPLOYEE THAT THEY'RE HIRING AND THAT'S A BIG LOOPHOLE THAT HAS TO BE CORRECTED. 

SUP. MOLINA, CHAIR: OKAY. WE HAVE, FOR PUBLIC COMMENT UNDER THIS ITEM, S-1 AND 66, WE'RE GOING TO TAKE TOGETHER, DR. GENEVIEVE CLAVREUL AND MR. PETER BAXTER. MR. ROBINSON, YOU DID FILL OUT YOUR TIMECARD IN ENOUGH TIME. YOU CAN SPEAK UNDER PUBLIC COMMENT. TIMECARD! NAME CARD. [ LIGHT LAUGHTER ] 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. YOU KNOW, AS USUAL, YOU KNOW, YOU ASK MANY OF THE GOOD QUESTIONS. I JUST WONDER WHAT WE'RE GOING TO GO WITH THAT. IT'S OBVIOUS THAT MANAGEMENT SYSTEMS ARE NOT IN PLACE. AND THE QUESTIONS YOU ARE ASKING ARE VERY GOOD QUESTIONS. AND THOSE THINGS ARE VERY EASY TO CORRECT. ALL IT TAKES IS EFFICIENT LEADERSHIP. AN IMPLEMENTATION OF MANAGEMENT SYSTEM TO MAKE SURE, YOU KNOW, BEHAVIOR OR CURE. LIKE AN EXAMPLE, IF YOU ASK FOR EVERY YEARLY EVALUATION, WHAT SYSTEM IS IN PLACE TO MAKE SURE THAT HAPPENS? AND IF IT DOESN'T HAPPEN, WHAT'S GOING TO BE DONE? AND IT DON'T TAKE, YOU KNOW, A GENIUS TO DO THAT. IT JUST TAKE SOMEBODY COMMITTED TO DO THE RIGHT THING. I AM VERY CONCERNED AGAIN ABOUT THE NAVIGANT REPORT. AND TO THE S-1, WE REALLY DID NOT GET A REPORT ON KING DREW. WE GOT A REPORT ON DREW. AND NOTHING WAS MENTIONED ABOUT THE C.M.S. INSPECTION AND REPORT AND WHAT CORRECTIONS OR BEHAVIORS WERE IMPLEMENTED TO DEAL WITH THOSE ISSUES. AND, OF COURSE, MISS KAE ROBERTSON IS TOO BUSY BEING OUT OF TOWN, LIKE SHE USUALLY DOES ON EVERY WEEKEND. AND I THINK, TALKING ABOUT TIMECARD, I THINK IT'S EXTREMELY IMPORTANT, AT THIS STAGE OF THE GAME, THAT WE KNOW HOW MANY EMPLOYEES FROM NAVIGANT ARE ACTUALLY WORKING AT KING DREW AND THE HOURS THEY ARE WORKING AT KING DREW. I MEAN, THIS HAS NOT COME-- AND I KNOW A COUPLE OF YOU HAVE ASKED FOR THAT BUT WE HAVE NOT SEEN THAT. AND IT IS OBVIOUS, FROM THE LACK OF CORRECTION, WHICH HAVE HAPPENED IN THE LAST SEVEN MONTHS, THE TEAM OF NAVIGANT IS NOT DOING THEIR JOB, NOT COUNTING THE ONE FROM D.H.S. AND, YOU KNOW, WE ARE PAYING A VERY LARGE AMOUNT OF MONEY. AND FOR US TO EVEN HEAR TODAY THAT WE ARE PUTTING ANOTHER $175,000 TO GET ANOTHER CONSULTANT TO TRY TO MAKE UP OUR MIND ON WHICH GROUP IS GOING TO COME TO TAKE OVER THE HOSPITAL IS LUDICROUS. THE COUNTY OF THIS SIZE, WITH THE NUMBER OF PEOPLE YOU DO HAVE IN THE 24,000-PLUS PEOPLE WORKING FOR THE DEPARTMENT OF D.H.S., YOU SHOULD HAVE EXPERTS HERE ENOUGH TO DO THAT JOB. AND WHY ARE WE SELECTING THAT FIRM IN PARTICULAR? AGAIN, WAS IT AN R.F.P.? THE RECOMMENDATION FROM CALIFORNIA-- I MEAN, CATHOLIC HEALTH WEST, CEDARS-SINAI AND CITRUS VALLEY WOULD NOT BE MY FAVORITE RECOMMENDATION BECAUSE THOSE THREE HOSPITALS HAVE MAJOR PROBLEMS WITH NURSING ISSUES AND ARE NOT VERY DOING WELL WITH THE RELATIONSHIP WITH THE UNION, ET CETERA, SO THEIR RECOMMENDATION WILL BE VERY DUBIOUS TO ME. THANK YOU. 

SUP. MOLINA, CHAIR: MR. BAXTER? 

PETER BAXTER: MADAM CHAIR, MEMBERS OF YOUR HONORABLE BOARD, MR. JANSSEN, LADIES AND GENTLEMEN, MY NAME IS PETER BAXTER AND I LIVE IN LOS ANGELES. IT IS RESPECTFULLY SUBMITTED THAT THIS AGENDA ITEM PROVIDES FOR A REPORT ON THE STATUS OF REFORM AT KING DREW MEDICAL CENTER. THERE IS A COMPARISON TO BE DRAWN BETWEEN THE LEVEL OF PUBLIC DISCUSSION OVER THE KING DREW MEDICAL CENTER AND THE FIRE DEPARTMENT OF THE COUNTY OF LOS ANGELES. THE DIFFERENCE BETWEEN THESE TWO PUBLIC RESOURCES IN TERMS OF PUBLIC SCRUTINY IS LITTLE SHORT OF AMAZING. THE KING DREW DISCUSSION HAS ATTRACTED AND HAS-- AND THIS DISCUSSION CONTINUES TO ATTRACT THE MOST CAREFUL STUDY BY THE BOARD OF SUPERVISORS, THE HEALTH DEPARTMENT, NAVIGANT, AND THE NEWS MEDIA, PARTICULARLY "THE LOS ANGELES TIMES". IN COMPARISON, THERE APPEARS TO BE NO ONGOING STUDY OF THE OPERATIONS OF THE FIRE DEPARTMENT, EVEN THOUGH THE DISASTER OF 9/11 WAS, AS IT REMAINS, A PUBLIC SPECTACLE OF FIREFIGHTING BEING REVEALED AS A VOCATION IN SHAMBLES. THE WHOLE UNDERTAKING, THAT IS, THE RESPONSE OF THE NEW YORK FIRE DEPARTMENT TO THAT EVENT, WAS A TOTAL FAILURE. HERE IN LOS ANGELES, WE FACE ANOTHER FIRE SEASON WHEN WE MAY EXPECT TO SUFFER THE LOSS OF LIFE AND PROPERTY FROM FIRE ON A SCALE UNKNOWN IN ANY OTHER PART OF THE WORLD. NOTHING IN MEDICINE COMPARES WITH THE DEVASTATION OF 9/11 IN MANHATTAN. AND YET THE STUDY OF KING DREW IS CONDUCTED PUBLICLY IN EXCRUCIATING DETAIL WHILE THE OPERATION IN MANHATTAN ON 9/11 IS SHIELDED BY WHAT APPEARS TO BE A MYSTERIOUS TABOO. AND, RECENTLY, THE LAST TWO WEEKS, WE HAD A FIRE IN LONG BEACH AND THIS FIRE WAS IN A TWO-STORY BUILDING. EVERYTHING WAS LOST. THEY HAD 50 FIREFIGHTERS THERE AND THEY HAD ALL THE WATER THAT THEY COULD HAVE AND WHAT WAS NOT DESTROYED BY FIRE WAS DESTROYED BY FLOODING. THERE'S JUST NO WAY YOU CAN GET ANY SENSE OUT OF FIGHTING FIRE WITH A SYSTEM THAT KILLS PEOPLE, AS IT DID WITH NEARLY 3,000 PEOPLE IN MANHATTAN AND, ALTHOUGH THERE WERE NO LIVES LOST IN LONG BEACH TWO WEEKS AGO, NEVERTHELESS, THE RESULT WAS TOTAL FAILURE, ALL OF WHICH IS RESPECTFULLY SUBMITTED AND I THANK YOU, MADAM CHAIR. 

SUP. MOLINA, CHAIR: THANK YOU SO MUCH. OKAY. WE WILL RECEIVE AND FILE THOSE TWO REPORTS. ALL RIGHT. ANYTHING ELSE? IF NOT, WE HAVE PUBLIC COMMENT. ALL RIGHT. DEBORAH BERLIN, ERNEST SMITH, GRACIE GRAY AND MR. ROBINSON. 

DEBORAH BERLIN: THANK YOU FOR THE OPPORTUNITY TO SPEAK BEFORE THIS BOARD TODAY. MY NAME IS DEBORAH BERLIN. I AM A 36-YEAR EMPLOYEE OF THE COUNTY OF LOS ANGELES, THE LAST 17 YEARS AT THE L.A.C./U.S.C. MEDICAL CENTER. I'M CURRENTLY AN INFORMATION SYSTEMS MANAGER WITH A BASE SALARY OF APPROXIMATELY $100,000. I AM HERE TODAY WITH A MATTER THAT SHOULD CAUSE YOU DISCOMFORT. A LOT HAS BEEN SAID THIS PAST YEAR ABOUT THE SAD EVENTS AT THE M.L.K. KING DREW MEDICAL CENTER. HOW LONG DID THOSE PROBLEMS GO ON TO HAVE REACHED THE MAGNITUDE THAT WE'VE ALL READ ABOUT IN THE PAPERS? SINCE I BEGAN WITH THE COUNTY IN 1969, I HAVE RECEIVED NOTHING BUT GLOWING PERFORMANCE EVALUATIONS, HAVE STEADILY RISEN THROUGH THE RANKS AS WELL. MY LAST PERFORMANCE EVALUATION WAS IN 1998 AND I WAS RATED OUTSTANDING. IN 1999, I EXERCISED MY RIGHTS BY FILING A COMPLAINT WITH THE CIVIL SERVICE COMMISSION FOR UNFAIR DISCIPLINE TAKEN AGAINST ME FOR FOLLOWING THE DIRECTIONS OF MY SUPERIORS AT THE L.A.C./U.S.C. MEDICAL CENTER. I PREVAILED AT THE COMMISSION. DISCIPLINE WAS OVERTURNED. THE COMMISSION ALSO WENT ON RECORD INDICATING THAT IT WAS NOT APPROPRIATE FOR THE DEPARTMENT OF HEALTH SERVICES TO USE EMPLOYEES AS SCAPEGOATS FOR THEIR BAD DECISIONS. SHORTLY AFTER THE DECISION WAS FINALIZED, I WAS REMOVED FROM MY POSITION AFTER BEING TOLD THAT, BECAUSE I EXERCISED MY RIGHTS, I DID NOT DESERVE A MANAGEMENT POSITION. FOR 1-1/2 YEARS THEREAFTER, I WAS SENT TO ISOLATION, NO WORK, NO DUTIES, NO POTABLE WATER, NO SANITARY RESTROOMS, NO CONTACT WITH ANYONE, INCLUDING NO RESPONSE TO ANY MESSAGES, ALL WITH THE FULL KNOWLEDGE AND CONCURRENCE OF THEN ACTING C.E.O. I ALSO HAVE A LETTER FROM THE OFFICE OF HUMAN RESOURCES INDICATING THAT THIS WOULD BE PERCEIVED AS RETALIATION BY THE COURTS AND/OR THE COMMISSION. I WAS PAID MY SALARY TO DO NO WORK. IN OTHER WORDS, THE TAXPAYERS GOT NOTHING IN RETURN. DID THE RETALIATION STOP THERE? NO. DID ANYONE CARE? IT APPEARS NOT. IS THIS UNIQUE? ABSOLUTELY NOT. WHILE PROMISES HAVE BEEN MADE OVER AND OVER, LITTLE HAS CHANGED TO DATE. IT'S ACKNOWLEDGED I DON'T HAVE APPROPRIATE WORK OR SUFFICIENT WORK WHAT FEW MINUTES OF THE DAY I CAN STRETCH IT TO BE. ASKING FOR WORK CONTINUES TO FALL ON DEAF EARS. ASKING FOR A PERFORMANCE EVALUATION GOES NOWHERE. ASKING ME TO USE MY PROVEN SKILLS IS IGNORED. IN OTHER WORDS, I'M PAID AND NOT ASKED TO WORK FOR IT. I GUESS THIS IS GOOD WORK IF YOU CAN GET IT. I, ON THE OTHER HAND, FIND THIS UNETHICAL TO THE TAXPAYERS AND WOULD PREFER TO WORK FOR MY SALARY. AT MINIMUM, I BELIEVE IT'S BLATANT RETALIATION. AFTER PUSHING OVER AND OVER FOR RESOLUTION, THE OFFICE OF AFFIRMATIVE ACTION AND D.H.S. AGREED TO MEDIATE. AGAIN, IT WAS ACKNOWLEDGED I DID NOT HAVE SUFFICIENT OR APPROPRIATE WORK. IN FACT, I WAS ALSO TOLD TO STOP ADVISING MANAGEMENT THAT I DID NOT HAVE WORK AND I WAS TOLD TO GO OCCUPY MY TIME DOING WHATEVER I WANTED TO DO. I ENTERED THIS PROCESS IN GOOD FAITH AND HOPEFUL FOR AN APPROPRIATE RESOLUTION. D.H.S. MADE PROMISE AFTER PROMISE AND DELIVERED NOTHING. 

SUP. MOLINA, CHAIR: PLEASE SUMMARIZE. YOUR TIME IS UP. 

DEBORAH BERLIN: I CAN FIND NO EVIDENCE THAT ANYONE IN THE DEPARTMENT OF D.H.S., LET ALONE L.A.C./U.S.C. HAS BEEN HELD ACCOUNTABLE FOR BLATANT WASTE OF TAXPAYERS FUNDS. I CAN FIND NO EVIDENCE THAT ANYONE AT D.H.S. IS BEING HELD ACCOUNTABLE. 

SUP. MOLINA, CHAIR: THANK YOU VERY MUCH, MISS BERLIN. MR. SMITH. 

ERNEST H. SMITH: YES. I WOULD LIKE TO SPEAK TO THE PREVIOUS DISCUSSION ON KING HOSPITAL. WHEN I WAS A STUDENT IN MEDICAL SCHOOL STUDYING PSYCHIATRY, WE WERE ALWAYS TOLD THAT, IF YOU BUY THE BASIC PREMISE OF THE SCHIZOPHRENIC, YOU WILL BELIEVE EVERYTHING THEREAFTER BECAUSE IT MAKES SENSE, IT'S LOGICAL. THEREFORE, YOU HAVE TO BE VERY CAREFUL OF THE BASIC PREMISE. THE BASIC PREMISE WITH KING HOSPITAL, NUMBER ONE, WOULD BE TIMECARD FRAUD, INCOMPETENCE, ALL KINDS OF THINGS. THOSE ARE BASIC PREMISES WHICH HAVE NOT BEEN EXAMINED. NUMBER ONE, NO ONE LOOKS AT KING IN TERMS OF ITS MISSION AND THAT MUCH OF THE WAY THAT THAT HOSPITAL OPERATES STARTED IN 1967. EVERYBODY LOOKS AT KING AS THOUGH IT WERE HARBOR HOSPITAL OR BIG COUNTY OR WHAT USED TO BE YOUR WAY OF BEHAVIOR IN LOS ANGELES COUNTY. THAT'S NOT TRUE. NO ONE LOOKS AT KING AS THE HOSPITAL WITHOUT WALLS, WHICH WAS ACCEPTABLE WHEN THAT HOSPITAL WAS OPEN BUT SOMEHOW OR OTHER IS NO LONGER ACCEPTABLE. NO ONE LOOKS AT THE WHOLE CONCEPT OF PRIVATE PRACTICE PLANS AND THE REASON FOR IT, WHERE THE COUNTY ALLOWS PRIVATE PRACTICE AMONGST ITS PHYSICIANS MAINLY BECAUSE THEY COULDN'T GET THOSE PHYSICIANS TO STAY IN HARBOR HOSPITAL OR BIG COUNTY HOSPITAL FULL TIME BECAUSE THEY WERE IN THEIR PRIVATE OFFICES AND MANY OF THEM WERE DOING EXACTLY WHAT WE WERE ACCUSED OF DOING AT KING HOSPITAL. NOW, NONE OF THEM ARE ACCUSED OF TIMECARD FRAUD, NONE OF THEM WERE FIRED, NONE OF THEM WENT TO JAIL. WHAT HAPPENED WAS THEY BUILT PRIVATE PRACTICE SPACES ON THE CAMPUSES OF BOTH OF THOSE HOSPITALS AND THOSE PHYSICIANS NOW PRACTICE PRIVATELY ON THE PREMISES OF BIG COUNTY AND HARBOR AND THEREFORE THEY NEVER LEAVE THE PREMISES BUT THEY'RE STILL NOT AT A COUNTY DESK. SO, IN OTHER WORDS, YOU HAVE BASIC PREMISES THAT YOU NEED TO EXAMINE AND, INSTEAD OF GOING OVER AND OVER THE SAME THING, WHERE YOU REALLY END UP WITH NO SOLUTIONS, THEN IT'S BECAUSE YOUR BASIC PREMISE IS WRONG. NOW, THE OTHER THING, THAT, WHEN YOU BEGIN TO LOOK AT DR. GARTHWAITE AND HIS FLOUNDERING, REMEMBER WELL THAT THERE WAS NO KING HOSPITAL BEFORE 1967 AND, WHEN THEY STARTED CONSTRUCTION, THAT IT TOOK THEM ABOUT A YEAR AND A HALF TO CONSTRUCT BUT, BY 1970, THEY HAD-- '71, THEY WERE BRINGING IN THE FIRST GROUPS OF PEOPLE TO START BUILDING THAT HOSPITAL. AND, IN JANUARY OF 1972, WE WERE SUPPOSED TO BE READY TO OPEN. NOW, IF WE WERE ABLE TO BUILD A BRAND-NEW HOSPITAL AND OPEN IT WITHIN 1-1/2 YEARS, I CAN'T UNDERSTAND WHY YOU'RE FLOUNDERING NOW JUST TRYING TO FIX, NOT BUILD, NOT CONSTRUCT, NOT RE-ANYTHING BUT JUST FIX, AND IT TAKES MORE TIME TO FIX THAN IT TOOK TO BUILD AND FILL BECAUSE THE BASIC PREMISE IS WRONG. DR. GARTHWAITE HAS GIVEN YOU GENERALITIES AND, AS I ALWAYS SAY, HE DOES A LOT OF GOBBLETY GOOK. AND THE OTHER THING IS, HE GIVES YOU BOTH SIDES OF THE EQUATION IN ONE SPEECH; THEREFORE, YOU LEAVE HERE CONFUSED. YOU NEED TO DO A THOROUGH REEXAMINATION OF THE BASIC PREMISE OF KING AND BEGIN TO SPEAK TO THOSE INDIVIDUALS WHO YOU THINK ARE CRIMINAL AND GET THEIR SIDE OF THE STORY. 400 PEOPLE WERE RELEASED SINCE-- ACCORDING TO MR. HENRY. YOU NEED TO TALK TO EACH ONE OF THOSE INDIVIDUALS AND FIND OUT WHAT WAS THE ISSUE, WHY WERE THEY RELEASED, DID THEY HAVE A FAIR TRIAL AND WHAT REALLY IS THE TRUTH. THANK YOU. 

GRACIE GRAY: GOOD AFTERNOON. YOU ALL KNOW ME. SOME OF YOU DO. MY NAME IS GRACIE AND I'M HERE, I DON'T KNOW, YOU KNOW, GOD WORKS IN A MYSTERIOUS WAY. HE SAID, BY HEARING, THEY WOULD HEAR AND NOT GET THE SENSE OF IT. AND BY SEEING, THEY WILL SEE BUT NOT STILL GET THE SENSE OF IT. IT WAS JUST AN COINCIDENCE THAT I HAD YOU ALL ON MY MIND FOR QUITE SOME TIME AND I CAME UP ON THE HILL AND I HAPPENED TO COME IN AND I WENT THROUGH DIFFERENT DOORS BUT THEY WAS CLOSED. THEN, WHEN I CAME BACK, I FOUND OUT THAT IT WAS ON THE DREW. I HAVE PICTURES HERE, ONE OF MY SONS, WINTHROP FATHER, THAT WAS ON A LIFE SUPPORT MACHINE THERE IN SACRAMENTO. THEY WAS GOING TO PULL THE PLUG AND, WHEN I CALLED, THE DAUGHTER TOLD ME THEY WERE GOING OVER TO DISCUSS ABOUT PULLING THE PLUG AND I CALLED THE DOCTOR BACK AND I SAID, "DON'T DO THAT." AND HE SAID, "WHO ARE YOU?" I SAID, "I HAVE TWO SONS BY HIM. CAN I GET UP THERE AND SPEAK TO YOU ABOUT IT?" HE SAID, "OKAY, WE WILL HOLD IT." THERE HE IS. WILL GIVE THEM THIS PICTURE, PLEASE? HE LEFT. WE WENT BACK UP THERE, AS A MATTER OF FACT, THEY CAUGHT ME IN THE ROOM AND THE NEXT DAY BEFORE I LEFT, THEY SAID, "AREN'T YOU TONYA?" SHE SAID, "YES." THERE'S A MIRACLE HAS HAPPENED IN THIS HOSPITAL. YOUR FATHER IS SITTING UP IN THE BED. SO I MADE ARRANGEMENTS FOR HIM TO COME DOWN HERE AND TO A CONVALESCENT HOSPITAL. I HID HIM. IT WAS A ALL LATINO NEIGHBORHOOD. HERE'S A PICTURE OF HIM AFTER HE GOT DOWN HERE IN THIS LATINO NEIGHBORHOOD AND EVERY MORNING, HE'LL CALL, "GRACIE, ARE YOU COMING TO GET ME OR SENDING SOMEONE TO GET ME FOR THE DREW HOSPITAL?" I SAY, "WELL, FRED, YOU KNOW, PEOPLE ARE GOING TO DO WHAT THEY WANT TO DO." I WILL GET HIM UP, GET HIS ACTION AND EVERYTHING. THE PLACE I WAS LIVING AT, IT WAS DEPLORABLE. TOILETS FELL DOWN. CA-CA CAME DOWN AND THE FIREMEN CAME TO DO WET VAC AND HE TOLD A MAN, I SAID, "I WILL PUT YOU UNDERNEATH THE JAIL HOUSE." YOU HAVE A MAN HERE THAT'S ON LIFE SUPPORT. EVERY MORNING, HELP ME. JEHOVAH, HELP ME. THIS MAN CALLED PARAMEDICS. AND THEY CAME IN. THE LAST TWO THAT CAME IN, USUALLY WHEN THEY COME IN, I LAY MY HAND ON HIM AND HE WOULD LEAVE IN HIS OWN WHEELCHAIR. BUT THE LAST ONE, HE CAME IN AND I [ INAUDIBLE ] LATINO BECAUSE HE HAVE SON NAMED PHILIPPE, THEY TOOK HIM OUT OF THE WHEELCHAIR, SO THEY ROLLED HIM OUT. THAT WAS ABOUT 7:30 IN THE MORNING. I WOKE UP AT ABOUT 2:30 IN THE MORNING AND HE STILL HAD NOT CAME UP, SO I WAS CALLING AROUND TO SEE WHERE HE WAS AT. HE HAPPENED TO BE IN CULVER CITY IN A HOSPITAL. AND, WHEN I GOT THERE, HE WAS-- I MEAN, HIS VOICE WAS STRONG. HE WAS VERY STRONG. AND ALL OF A SUDDEN, (SIGHS)... 

SUP. MOLINA, CHAIR: WANT TO SUMMARIZE, MISS GREY? 

GRACIE GREY: YES, MA'AM, I WILL. AND IT SEEMED THAT WHEN HE WENT INTO THAT HOSTEL, THEY TOOK DREW RIGHT ALONG WITH HIM, INCLUDING ONE OF THE FEMALES THAT HE WAS WORKING WITH, OKAY? I'M NOT, I'M NOT A WHISTLE BLOWER, I'M A SAXOPHONE BLOWER... 

SUP. MOLINA, CHAIR: THANK YOU SO MUCH. 

GRACIE GREY: BUT THIS IS MY SON'S FATHER AND MY SON HAPPENED TO BE THROWN OUT OF HIS APARTMENT, THE ONE THAT... 

SUP. MOLINA, CHAIR: THANK YOU, MISS GREY. 

GRACIE GREY: ...THAT'S MENTALLY ILL, OKAY? AND... 

SUP. MOLINA, CHAIR: ALL RIGHT. IS THERE'S NOTHING ELSE TO COME BEFORE THE MEETING? ARE THERE OTHER ISSUES? IF NOT, THIS MEETING IS ADJOURNED. GO INTO CLOSED SESSION. 

CLERK VARONA-LUKENS: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LABOR NEGOTIATORS DAVID E. JANSSEN, AND DESIGNATED STAFF AS INDICATED ON THE POSTED AGENDA. THANK YOU. 
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